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Preface

Manual Overview

The SEL-3031 Serial Radio Transceiver manual includes the information 

needed to properly install and operate the product.

The scope of this manual includes specifications, installation, mechanical 

information, self-monitoring, and alarming.

An overview of each manual section and topics follows.

Preface. Describes the manual organization and conventions used to 

present information.

Section 1: Introduction and Overview. Describes the basic features and 

functions of the SEL-3031, and lists the specifications.

Section 2: Installation. Describes how to mount and wire the SEL-3031; 

illustrates wiring connections for various applications.

Section 3: Job Done Examples. Describes common SEL-3031 applications.

Section 4: Settings and Commands. Describes settings and commands for use 

with the SEL-3031.

Section 5: Performance Monitoring, Testing, and Troubleshooting. Lists common 

operating and troubleshooting questions.

Appendix A: Firmware and Manual Versions. Details differences between 

firmware versions. Provides a record of changes made to the manual.

Appendix B: Firmware Upgrade Instructions. Provides instructions for 

upgrading the firmware in the SEL-3031.

Appendix C: SEL-3044 Encryption Card. Describes how the encryption card 

operates to secure wireless data. Provides installation information.
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Safety Information
Dangers, Warnings, and Cautions

This manual uses three kinds of hazard statements, defined as follows:

Safety Symbols

The following symbols are often marked on SEL products.

DANGER
Indicates an imminently hazardous situation 
that, if not avoided, will result in death or 
serious injury.

WARNING
Indicates a potentially hazardous situation 
that, if not avoided, could result in death or 
serious injury.

CAUTION
Indicates a potentially hazardous situation 
that, if not avoided, may result in minor or 
moderate injury or equipment damage.

CAUTION
Refer to accompanying documents.

ATTENTION
Se reporter à la documentation.

Earth (ground) Terre

Protective earth (ground) Terre de protection

Direct current Courant continu

Alternating current Courant alternatif

Both direct and alternating current Courant continu et alternatif

Instruction manual Manuel d’instructions
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Safety Marks

The following statements apply to this device.

General Safety Marks 

For use in Pollution Degree 2 environment. Pour l’utilisation dans un environnement de 

Degré de Pollution 2.

Terminal Ratings

Wire Materials

Use copper conductors only.

Spécifications des bornes

Type de filage

Utiliser seulement conducteurs en 

cuivre.

Wire Size

12–26 AWG

Calibre de fil

12–26 AWG

Tightening Torque

Terminal Blocks: 0.8 Nm (7 in-lb)

Couple de serrage

Borniers : 0,8 Nm (7 livres-pouce)

Other Safety Marks (Sheet 1 of 2)

DANGER
Disconnect or de-energize all external 
connections before opening this device. 
Contact with hazardous voltages and currents 
inside this device can cause electrical shock 
resulting in injury or death.

DANGER
Débrancher tous les raccordements externes 
avant d’ouvrir cet appareil. Tout contact avec des 
tensions ou courants internes à l’appareil peut 
causer un choc électrique pouvant entraîner des 
blessures ou la mort.

WARNING
Have only qualified personnel service this 
equipment. If you are not qualified to service 
this equipment, you can injure yourself or 
others, or cause equipment damage.

AVERTISSEMENT
Seules des personnes qualifiées peuvent 
travailler sur cet appareil. Si vous n’êtes pas 
qualifiés pour ce travail, vous pourriez vous 
blesser avec d’autres personnes ou 
endommager l’équipement.

WARNING
Operator safety may be impaired if the device 
is used in a manner not specified by SEL.

AVERTISSEMENT
La sécurité de l’opérateur peut être 
compromise si l’appareil est utilisé d’une façon 
non indiquée par SEL.

WARNING
Atmospheric electrical charge accumulation 
can cause potential between the conductor and 
shield of the feedline, or cause lightning to 
strike an antenna. A lightning protector should 
be installed to prevent damage to equipment or 
injury to personnel.

AVERTISSEMENT
L'accumulation de charges électriques de type 
atmosphérique peut être la cause d'une 
différence de potentiel entre le conducteur et 
le blindage de la ligne d'alimentation ou peut 
attirer la foudre sur l'antenne. Un parafoudre 
devrait être installé pour prévenir les 
dommages à l'équipement ou les blessures au 
personnel.
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WARNING
Do not look into the fiber (laser) 
ports/connectors.

AVERTISSEMENT
Ne pas regarder vers l’extremité des ports ou 
connecteurs de fibres pour laser.

WARNING
Do not look into the end of an optical cable 
connected to an optical output.

AVERTISSEMENT
Ne pas regarder vers l’extrémité d’un câble 
optique raccordé à une sortie optique.

WARNING
This device is shipped with default passwords. 
Default passwords should be changed to 
private passwords at installation. Failure to 
change each default password to a private 
password may allow unauthorized access. SEL 
shall not be responsible for any damage 
resulting from unauthorized access.

AVERTISSEMENT
Cet appareil est expédié avec des mots de 
passe par défaut. A l’installation, les mots de 
passe par défaut devront être changés pour 
des mots de passe confidentiels. Dans le cas 
contraire, un accés non-autorisé á l’équipement 
peut être possible. SEL décline toute 
responsabilité pour tout dommage résultant de 
cet accés non-autorisé.

CAUTION
Although the power level is low, concentrated 
energy from a directional antenna may pose a 
health hazard. Do not allow users to come 
closer than 23 cm (9 in) to the antenna when 
the transmitter is operating in indoor or 
outdoor environments in the 900-MHz band.

ATTENTION
Bien que le niveau de puissance soit bas, 
l'énergie concentrée d'une antenne 
directionnelle peut être un danger pour la 
santé. Ne pas autoriser les usagers à 
s'approcher à moins de 23 cm (9 po) de 
l'antenne quand l'émetteur est en opération 
dans un environnement intérieur ou extérieur 
dans la bande des 900-MHz.

CAUTION
The radio contains devices sensitive to 
electrostatic discharge (ESD). Undetectable 
permanent damage can result if you do not use 
proper ESD procedures. Ground yourself, your 
work surface, and this equipment before 
removing any cover from this equipment. If 
your facility is not equipped to work with these 
components, contact SEL about returning this 
device and related SEL equipment for service.

ATTENTION
La radio contient des circuits sensibles aux 
décharges électrostatiques (DES). Des 
dommages permanents non-décelables 
peuvent résulter de l’absence de précautions 
contre les DES. Raccordez-vous correctement à 
la terre, ainsi que la surface de travail et 
l’appareil avant d’en retirer un panneau. Si vous 
n’êtes pas équipés pour travailler avec ce type 
de composants, contacter SEL afin de 
retourner l’appareil pour un service en usine.

Other Safety Marks (Sheet 2 of 2)
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Section 1
Introduction and Overview

Overview

The SEL-3031 is a 900-MHz, license-free, spread-spectrum radio. The radio operates 

in the ITU Region 2 ISM band of 902–928 MHz through the use of a fast frequency-

hopping algorithm for noise immunity and long-distance operation.

The SEL-3031 prevents the need for multiple sets of radios or expensive dedicated 

fiber transmitting over long distances. Figure 1.1 shows the flexibility of the SEL-3031 

in providing DNP3 SCADA information, MIRRORED BITS® control for reclosing 

coordination, and engineering access to the SEL-651R Recloser Control. 

Figure 1.1 Point-to-Point Product Overview

Figure 1.2 shows the flexibility obtained when using the SEL-3031 in point-to-

multipoint (P2MP) applications providing DNP3 or Modbus SCADA information from 

many remotes to one master.

Pole-Mount Radio
Substation Radio

DNPEngineering
Access

MIRRORED BITS

SEL-3031

SEL-351S

SEL-651R

SEL-3031

SEL-3351
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1.2

Figure 1.2 Point-to-Multipoint Product Overview

Features, Benefits, and Applications
➤ Dual Radio Operating Modes Provide Flexibility. Supports 

point-to-point (P2P) radio operation for fast teleprotection, 

distribution automation, distributed generation, and economical 

backup protection. Apply point-to-multipoint (P2MP) radio operation 

for SCADA and other data-gathering from remote locations.

➤ Three Ports in One Radio Reduce Costs. Simultaneously 

communicates with as many as three independent ports and protocols 

via point-to-point radio operation.

➤ Low Latency Enables Fast Control. Transfers control commands 

with a typical 4.8 ms latency with SEL MIRRORED BITS® 

communications.

➤ Strong Security Thwarts Attackers. Protects critical data and repels 

malicious attacks with optional encryption card, using session 

authentication and strong 256-bit Advanced Encryption Standard 

(AES) technology.

➤ Tough Radio Operates in Extreme Conditions. Is designed, built, 

and tested for trouble-free operation in extreme temperature, 

electromagnetic interference, shock, and vibration conditions.

➤ No Licensing Reduces Delays and Expenses. Uses the license-free, 

900-MHz ISM band for on-time, on-budget projects.

➤ Mounting Options Simplify Installation. Order your SEL-3031 in 

one of three different packages: rack-mount, wall-mount, and NEMA 

3R prewired radio solution.
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Models, Options, and Accessories

1.3

➤ Multiple Protocols Satisfy Interconnection Requirements. 

Communicate with industry-standardized byte-oriented protocols, 

such as DNP3, Modbus®, SEL MIRRORED BITS communications, 

IEEE C37.118 Synchrophasors, SEL Fast Messaging, and SEL 

ASCII.

➤ Flexible Serial Port Options Match Integration Needs. Order 

serial Port 1 as EIA-232, EIA-485, or optical fiber to easily connect 

to your existing devices.

➤ Simple Settings Streamline Radio Commissioning. Use 

ACSELERATOR QuickSet® SEL-5030 Software for all settings.

➤ USB Management Port Conveniently Connects to PC. Make 

settings changes, verify status information for proper installation, and 

verify radio performance without affecting the three serial channels.

Models, Options, and Accessories

Standard Features
➤ P2P and P2MP operation modes

➤ Three EIA-232 serial ports

➤ IRIG-B time code input

➤ Radio synchronization with collocated radios

➤ Power supply

➢ Wall mount: 9–30 Vdc

➢ Rack mount: 24–48 Vdc, 125/250 Vac or Vdc

➤ ACSELERATOR QuickSet software

➤ Protocol pass-through support

➢ DNP3

➢ Modbus

➢ SEL MIRRORED BITS

➢ SEL Fast Messaging

➢ SEL ASCII

➢ IEEE C37.118 Synchrophasors

Optional Features
➤ One port EIA-485

➤ One port fiber-optic (SEL-2812 and SEL-9220 compatible)

➤ SEL-3044 Encryption Card

➤ Special frequencies for Brazil
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Accessories

Table 1.1 Radio Antenna and Cable Accessories 

Description Part Number

Feedline

RG-8X TNC Male to N Male Cable SEL-C964

RG-8X TNC Male to TNC Male Cable SEL-C965

LMR®-400 TNC Male to N Male Cable SEL-C966

LMR-400 TNC Male to TNC Male Cable SEL-C961

LMR-400 N Male to N Male Cable SEL-C968

7/8" HELIAX® N Male to N Male Cable SEL-C978

N Female to TNC Male Adapter 240-1809

Antenna

Low-Profile 3 dBi Gain Omnidirectional, N Female Connector 235-0003

Indoor 8" Vertical, TNC Male Connector 235-0108

5-Element 11.1 dBi Gain Yagi, N Female Connectora 235-0220

3-Element 8.5 dBi Gain Yagi, N Female Connectora

a Comes equipped with pipe-mounting hardware.

235-0221

11-Element 14.15 dBi Gain Yagi, N Female Connectora 235-0222

Vertical 7.15 dBi Gain Omnidirectional, N Female Connector 235-0232

Vertical 9.15 dBi Gain Omnidirectional, N Female Connector 235-0233

Antenna Mounting

Vertical Omnidirectional Mount for 14" Maximum Diameter 

Poles

240-0103

Yagi Mount for 14" Maximum Diameter Poles 240-0104

Mast Mount for Large Omnidirectional Antennas (1.3125" 

Maximum Diameter Antenna to 1.25" Maximum Diameter 

Mast)

240-0105

Mounting Bracket for Low-Profile Omnidirectional Radio 

Antennas

915900494

Surge Protection

Radio Surge Protector With N Male Connectors 200-2004
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Figure 1.3 Radio Antenna Connections

LMR-400 N Male to

N Male Cable (SEL-C968)

Radio Surge Protector With

N Female Connectors

(200-2004)

RG-8X TNC Male to N Male Cable (SEL-C964)

or

LMR-400 TNC Male to N Male Cable (SEL-C966)

3-Element 8.5 dBi Gain Yagi, N Female Connector (235-0221)

or

5-Element 11.1 dBi Gain Yagi, N Female Connector (235-0220)

SEL-3031
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Figure 1.5 SEL-3031 Rack Mount (Front and Rear)
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Figure 1.6 SEL-3031 Wall Mount (Front and Rear)
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Specifications

Compliance

Designed and manufactured under an 

ISO 9001 certified quality management 

system
UL Listed to U.S. and Canadian safety 

standards (File E220228; NRAQ, NRAQ7)

SEP (SEL-3044 encryption card): 

FIPS 140-2 Level 2 validated (historical, 

pending re-validation). FIPS certificate 

#1564 (consolidated certificate no. 0006).
Note that the current FIPS certificate is 

marked as historical. SEL is currently 

undergoing the FIPS re-validation process 

for the SEL-3044 card.

Also see Table 1.2.

General

Temperature Range

–40° to +85°C per IEC 60068-2-1 and 

60068-2-2

Operating Environment

Pollution 

Degree: 2

Relative 

Humidity: 5–95%, noncondensing

Maximum 

Altitude: 2000 m

Dimensions

Wall Mount: 43.9 mm x 219.7 mm x 

162.6 mm

(1.73 in x 8.66 in x 

6.40 in)

Rack Mount: 43.7 mm x 482.6 mm x 

160.0 mm
(1.72 in x 19.00 in x 

6.3 in)

Time-Code Input

Port 2, Pins 4 and 6

Format: Demodulated IRIG-B

Input 

Impedance: 333 

Accuracy: 5 milliseconds

Alarm Contact

Form B Contact 
(open when energized and passes diagnostics)

Operating 

Voltage: 250 Vdc or 190 Vac

Dielectric Test 

Voltage: 500 Vrms

Continuous 
Carry: 6 A

Communications

Communications Ports

Serial Port 1

Data Speed 

Without 

Encryption 

Card:

38400 bps (disables 

Port 2), 19200 bps, or 

9600 bps

Data Speed With 

Encryption 

Card:

19200 bps (disables 

Port 2) or 9600 bps

EIA-232, EIA-485 (ordering option)

Connector: 9-Pin D-Subminiature

Fiber-Optic Ordering Option

Connectors: 2 ST (Tx and Rx)

Encoding SEL-2812/SEL-9220 

Compatible

Wavelength: 850 nm multimode

Typical Tx 

Power: –13 dBm

Min. Rx 
Sensitivity: –29 dBm

Optical 

Budget: 16 dB

Compatible 

Fiber-Optic 

Core 

Diameter: 50, 62.5, or 200 m

Serial Port 2, 3 Standard EIA-232

Data Speed 

Without 
Encryption 

Card: 19200 bps or 9600 bps
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Data Speed With 

Encryption 

Card: 9600 bps 

Connector: 9-Pin D-Subminiature

Protocols

Modbus, DNP3, SEL MIRRORED BITS 
Communications (MB8), ACSELERATOR 

QuickSet SEL-5030 Software Support, 

SEL ASCII and Compressed ASCII, SEL 

Fast Messaging, IEEE C37.118 

Synchrophasors

Typical Latency

SEL-3031

MIRRORED BITS: 8.9 ms at 9600 bps

5.6 ms at 19200 bps

4.8 ms at 38400 bps

Standard: 4.9 ms at 9600 bps

4.3 ms at 19200 bps

3.8 ms at 38400 bps

SEL-3031 With SEL-3044 Encryption Card

MIRRORED BITS: 9.7 ms at 9600 bps

7.4 ms at 19200 bps

Standard: 5.7 ms at 9600 bps

5.3 ms at 19200 bps

Radio

Transmitter

Frequency Band: 902–928 MHz ISM band

Modulation: GFSK

Operating Mode: Point-to-Point

RF Connector: TNC

Power Output: 1 W (30 dBm) to 

100 mW (20 dBm) 
in steps of 1 dBm

Channel 

Bandwidth: 250 kHz

Receiver

Sensitivity: –97 dBm, –104 dBm with 

ARQ on

Bit Error Rate 
(BER): 10–6 at –97 dBm

Distance: 32 km (20 mi), line of 

sight

Error Detection: 32-bit CRC

Power Supply

Rated Supply Voltage

Wall-Mount 
Model: 12/24 Vdc

Low-Voltage 

Model: 24/48 Vdc

High-Voltage 

Model:

125/250 Vdc

110/240 Vac, 50/60 Hz

Input Voltage Range

Wall-Mount 
Model: 9–30 Vdc

Low-Voltage 

Model: 18–60 Vdc

High-Voltage 

Model: 85–275 Vdc; 85–264 Vac

Power Consumption

Wall Mount: 5 W

Rack Mount: 7 W

Power Consumption With SEL-3044 Card

Wall Mount: 6 W

Rack Mount: 8 W

Type Tests

Communications Equipment Tests

IEEE 1613-2003

Environmental Tests

Enclosure 

Protection: IEC 60529:2001

Vibration 

Resistance:

IEC 60255-21-1:1988

Class 1 Endurance

Class 2 Response
IEC 60255-21-3:1993

Class 2

Shock 

Resistance:

IEC 60255-21-2:1988

Class 1 shock withstand, 

bump

Class 2 shock response

Cold: IEC 60068-2-1:2007

–40°C, 16 hours
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Damp Heat, 

Cyclic:

IEC 60068-2-30:2005

25–55°C, 6 cycles, 95% 

relative humidity

Dry Heat: IEC 60068-2-2:2007

+85°C, 16 hours

Dielectric Strength and Impulse Tests

Dielectric 

(HiPot):

IEC 60255-5:2000

IEEE C37.90–2005

Impulse: IEC 60255-5:2000

0.5 J, 5 kV

RFI and Interference Tests

EMC Immunity

Standard: IEEE 1613, Class 2

Electrostatic 

Discharge:

IEC 61000-4-2:2008

8 kV contact discharge

15 kV air discharge

IEEE C37.90.3–2001

8 kV contact discharge

15 kV air discharge

Radiated RF 

Immunity:

IEC 61000-4-3:2008

10 V/m

IEEE C37.90.2–2004

35 V/m

Fast Transient, 

Burst 

Immunity:

IEC 61000-4-4:2004

4 kV @ 2.5 kHz, and 

5.0 kHz for 

communications ports, 

power supply, alarm 
contacts

Surge Withstand 

Capability 

Immunity:

IEC 60255-22-1:2007

2.5 kV common-mode

1 kV differential-mode

IEEE C37.90.1–2002

2.5 kV oscillatory, 4 kV 

fast transient for 

communications ports, 

power supply, alarm 

contacts

Conducted RF 

Immunity:

IEC 61000-4-6:2008

10 Vrms

Digital Radio 

Telephone RF 
Immunity:

ENV 50204-1995

Severity Level:

10 V/m at 900 MHz 

and 1.89 GHz

EMC Emissions

Radiated Emissions

FCC Part 15.247; ICES-001; RSS-247

This device complies with Part 15 of the 

FCC rules. Operation is subject to the 

following two conditions:

1. This device may not cause harmful 

interference, and
2. This device must accept any interference 

received, including interference that may 

cause undesired operation.

FCC Part 15, Class A; ICES-003
Note: This equipment has been tested and 

found to comply with the limits for a 

Class A digital device, pursuant to Part 

15 of the FCC Rules. These limits are 

designed to provide reasonable 

protection against harmful interference 
when the equipment is operated in a 

commercial environment.

This equipment generates, uses, and can 

radiate radio frequency energy and, if not 

installed and used in accordance with the 

instruction manual, may cause harmful 
interference to radio communications.

Operation of this equipment in a 

residential area is likely to cause harmful 

interference in which case the user will 

be required to correct the interference at 

his own expense.

FCC Section 15.21
Users manual for an intentional or 

unintentional radiator shall caution the 

user that changes or modifications not 

expressly approved by the party 

responsible for compliance could void 

the user’s authority to operate the 
equipment.
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Table 1.2 Certifications by Country

Country Authority Reference
Part Number 
Starts With

USA and 
Colombia

FCC ID: R34SEL-3031 3031

Canada IC 4468A - SEL3031 3031

Mexico COFETEL RCPSCE10 - 0574 3031

Brazil ANATEL ID: 2671-11-7001
EAN: (01)07898936514 02 8

30311
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RF Exposure Notice

The SEL-3031 transmitter module is approved for use only with specific 

antenna, cable, and output power configurations that have been tested and 

approved for use. Modifications to the SEL-3031, the antenna system, or 

to the power output that have not been explicitly specified by the 

manufacturer are not permitted and may render the radio non-compliant with 

applicable regulatory authorities. The radio equipment described in this manual emits 

radio frequency energy. Professional installation is required. The antenna(s) for this 

transmitter must not be collocated or operated in conjunction with any other antenna or 

transmitter.

CAUTION
Although the power level is low, concentrated energy from a directional antenna may pose a health 
hazard. Do not allow users to come closer than 23 cm (9 in) to the antenna when the transmitter is 
operating in indoor or outdoor environments in the 900-MHz band.

FCC Part 15 Notice

NOTE: Operation is subject to the following two conditions: 
(1) this device may not cause interference, and (2) this 
device must accept any interference, including 
interference that may cause undesired operation of the 
device.

This equipment has been tested and found to comply with the limits for Class A digital 

devices, pursuant to FCC Part 15 Rules. These limits are designed to provide 

reasonable protection against harmful interference when the equipment is operated in a 

commercial environment. This equipment generates, uses, and radiates radio frequency 

energy, and if not installed and used in accordance with the instruction manual, may 

cause harmful interference to radio communications. Operation of this equipment in a 

residential environment is likely to cause harmful interference, in which case the user 

will be required to correct the interference at his/her own expense.

RF EXPOSURE
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Radio Path

Spread-spectrum radios operating in the 900-MHz ISM band are limited by line-of-

sight. Radio line-of-sight is longer than optical line-of-sight because of the bending of 

the radio wave toward the surface of the earth. This radio horizon is typically 30 

percent longer than the visual horizon. The longer the communications path, the taller 

the antennas must be to maintain the line-of-sight.

Obstructions in the line-of-sight will impact the performance of the radio, as the 

strongest radio signal is communicated directly along the radio line-of-sight.

The line-of-sight between two antennas is shaped like an ellipse (called the Fresnel 

zone). The point exactly halfway between the two antennas is the widest part of the 

ellipse, as shown in Figure 2.1. At 900 MHz and 304.8 m (1000 ft) apart, the Fresnel 

zone is 4.9 m (16 ft) in diameter. At 32 km (20 mi) apart, it is 51.8 m (170 ft) in 

diameter. Anything within the Fresnel zone will obstruct and reduce signal strength and 

availability (the ground, buildings, vegetation, etc.). Table 2.1 depicts the maximum 

Fresnel zone diameter and path loss for some typical path distances.

Figure 2.1 Fresnel Zone

The formula used to calculate the widest distance of the Fresnel zone is as follows:

where:

b = radius of the Fresnel zone in meters

d = distance between transmitter and receiver in kilometers

f = frequency transmitted in GHz

d

b

b 17.32 d 4f=
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Obstructions in the Fresnel zone may also cause multipath interference because of 

reflective or refractive signals that may arrive at the receiver out-of-phase with the 

desired signal. The Fresnel zone should be 60 percent clear of obstructions for reliable 

radio communications. Large objects outside the Fresnel zone can cause reflections 

that may also affect reliable radio operation.

Transmitted Signal

According to FCC and IC, the maximum transmitted power allowed out of an antenna 

is 36 dBm EIRP (Equivalent/Effective Isotropically Radiated Power). This is the 

amount of equivalent power transmitted equally in all directions using a theoretical 

isotropic antenna. EIRP takes into account the power output of the radio, line feed 

losses, and the gain of the antenna. 

EIRP = SEL-3031 Power Output (dBm) – line-feed loss (dB) + antenna gain (dBi)

NOTE: Antenna/feedline configurations with net gains 
(antenna gain minus cable loss) greater than 8.0 dBi must 
have their output power limited to 341 mW. After setting 
the transmit power, measure the actual power.

Calculate the EIRP so you can set the proper output power on the SEL-3031 to stay in 

compliance with FCC and IC regulations; maximum power output from the antenna 

must not exceed 36 dBm. The SEL-3031 can transmit as much as 1 W or 30 dBm from 

the antenna port. If the calculated EIRP exceeds 36 dBm then you must reduce the power 

transmitted by the radio by reducing the transmit power setting TXPWR (see the TXPWR 

description in Radio Settings on page 4.12 for more information). The radio is shipped with 

TXPWR set to 30 dBm by default and can be reduced to 20 dBm. Look up feedline loss in 

Table 2.5. After setting the transmit power, measure the actual power.

Table 2.1 Fresnel Zone Diameter

900 MHz

Distance Between Antennas Fresnel Zone Diameter Freespace Loss (dB)

304.8 m (1000 ft) 4.9 m (16 ft) 81

1.6 km (1 mi) 11.6 m (38 ft) 96

8 km (5 mi) 25.9 m (85 ft) 110

16 km (10 mi) 36.6 m (120 ft) 116

24 km (15 mi) 44.8 m (147 ft) 119

32 km (20 mi) 51.8 m (170 ft) 122

40 km (25 mi) 57.9 m (190 ft) 124
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NOTE: This device has been designed to operate with the 
antennas listed in Table 2.2, and having a maximum gain 
of 14.1 dBi. Antennas not included in this list or having a 
gain greater than 14.1 dBi are strictly prohibited for use 
with this device. The required antenna impedance is 50 
ohms. Antennas having a gain of greater than 6 dB must 
use a feedline with enough loss to remain compliant with 
the maximum 36 dBm EIRP or reduce the radio 
transmitted power accordingly.

For example, if you wanted to design a radio system to achieve a 32-km (20-mi) radio 

path and run at the highest allowed transmitted power, one way would be to use the 

SEL-3031 with 15.2 m (50 ft) of LMR 400, lightning arrestor, and the 5-Element Yagi 

with 11.1 dBi of gain. The radio would transmit 30 dBm, the feedline loss is 1.95 dB, 

lightning arrestor loss is 0.15 dB, and the antenna gain is 11.1 dBi. The result would be 

39 dBm, which is 3 dBm higher than allowed by the FCC. You must reduce the radio 

transmit power setting TXPWR to 27 dBm. This would make your EIRP equal to 

36 dBm. After setting the transmit power, measure the actual power.

NOTE: To reduce potential radio interference to other 
users, the antenna type and its gain should be so chosen 
that the equivalent isotropically radiated power (EIRP) is 
not more than that permitted for successful 
communication.

Fade Margin

The fade margin determines the allowable signal loss between the transmitter and 

receiver. The fade margin is a function of system gains (transmitter power, receiver 

sensitivity, and antenna gain) and system losses (free space loss, losses because of the 

curvature of the Earth, and coaxial cable loss). Variations in temperature and humidity 

of the atmosphere with elevation causes the signals to bend more or bend less, resulting 

in fading at the receiver. The longer the path, the more likely deep fades will occur, 

requiring a greater fade margin. The formula to calculate free-space loss is shown 

below.

Free Space Loss = 92.4 + 20log(f) + 20log(d) dB

where: 

f = frequency in GHz

d = distance in km

Table 2.2 Antennas Permitted for Use With the SEL-3031

Antenna Type Maximum Allowed Gain

Yagi antenna 14.15 dBi or less

Omnidirectional antenna 9.15 dBi or less

Panel antenna 10.15 dBi or less
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Regional conditions also impact the probability of signal fade. Generally, mountainous 

terrain is more favorable, while tropical areas and those near large bodies of water are 

less favorable. One of the results from a site survey is the fade margin. A fade margin 

of 15 dB will yield good radio performance.

Site Survey

A line-of-sight path provides the most reliable transmission in all cases. As the distance 

increases the need for a clear path becomes more critical in creating a reliable, 

available radio link. If the radio path is short then a path study may not be needed. If 

you have a clear line-of-site to the other location without obstructions to the Fresnel 

zone (see Radio Path) then a path study is generally not needed. Longer distances may 

require a path study, a visual path inspection, and a spectrum analysis of the area to 

give a good indication of how high the antenna needs to be and how good the radio link 

will be.

Radio Interference

The SEL-3031 shares a frequency spectrum with other services and FCC Part 15 

(unlicensed) devices in ITU Region 2 (North, Central, and South America). This radio 

should not be used in Chile or Peru because of the regulations defining frequency 

allocation. Error-free communications may not be achievable in a given location, and 

some level of interference should be expected.

Consider the following points when setting up your system:

➤ Use directional Yagi antennas helps to narrow the radio path and 

provide the best path to prevent adjacent interference.

➤ If you suspect interference from a nearby, licensed system (such as a 

paging transmitter), it may be helpful to use horizontal polarization 

for all of the antennas in the network. Horizontal polarization can 

help improve signal availability but will likely increase the path loss. 

Horizontal polarization can provide an additional 20 dB of 

attenuation to interference because most other services use vertical 

polarization in these bands. Figure 2.2 demonstrates antenna 

mounting for both vertical and horizontal polarization.
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Figure 2.2 Antenna Polarization

➤ Multiple SEL-3031 systems can coexist in close proximity with 

minimal interference through the use of the built-in synchronism that 

allows you to synchronize collocated radios. The radios can be 

synchronized to transmit simultaneously to prevent interference from 

adjacent radios. See Radio Settings on page 4.12 to learn more about 

synchronizing radios.

➤ When constant interference is present in a particular frequency zone, 

it may be necessary to “lock out” that zone from the SEL-3031 

hopping pattern. The SEL-3031 includes a SKIP setting that removes 

interfered frequency zones from its hopping pattern. See Table 4.5 for 

more information on the skip zones and information on how to set the 

SKIP setting. In the USA, Canada, Colombia, and Mexico, a 

maximum of six zones may be skipped, per regulatory agency rules. 

Check the regulatory requirements for other countries.

➤ The RF power output for all SEL-3031 radios in your system should 

be set to the lowest level necessary for reliable communications. This 

decreases the likelihood of causing unnecessary interference to 

nearby systems. See Table 2.3 and Table 2.4 for more information on 

the different frequency zones.

Vertical Polarization Horizontal Polarization
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Feedlines

The feedline used with the antenna is as important as the antenna. Coaxial cables 

should have low attenuation and rated for outdoor use. Keep the feedline as short as 

possible to minimize signal loss between the radio and antenna. Times Microwave 

LMR®-400 or RG-8X A/U coax cables are preferred. If longer lengths or less loss is 

desired for the radio link then larger cable such as Andrew HELIAX® can be used. 

Table 2.5 lists the signal losses (in dB) for the indicated lengths of each cable type at 

900 MHz. 

Table 2.3 900-MHz Frequency Skip Zones (Part Numbers Starting With 
30310)

Zone 1 Zone 2 Zone 3 Zone 4 Zone 5 Zone 6 Zone 7 Zone 8

902.6–

903.8

904.1–

905.3

905.6–

906.8

907.1–

908.3

909.2–

910.4

910.7–

911.9

912.2–

913.4

913.7–

914.9

Zone 9 Zone 10 Zone 11 Zone 12 Zone 13 Zone 14 Zone 15 Zone 16

915.2–

916.4

916.7–

917.9

918.2–

919.4

919.7–

920.9

921.2–

923.0

923.3–

924.5

924.8–

926.0

926.3–

927.5

Table 2.4 900-MHz Frequency Skip Zones for Brazil (Part Numbers Starting 
With 30311)

Zone 1 Zone 2 Zone 3 Zone 9 Zone 10 Zone 11

902.6–903.8 904.1–905.3 905.6–906.8 915.2–916.4 916.7–917.9 918.2–919.4

Zone 12 Zone 13 Zone 14 Zone 15 Zone 16

919.7–920.9 921.2–923.0 923.3–924.5 924.8–926.0 926.3–927.5

Table 2.5 Length vs. Loss in Coaxial Cables at 900 MHz (Sheet 1 of 2)

Cable Type
3.05 meters 

(10 feet)
12.24 meters 

(50 feet)
30.48 meters 

(100 feet)
91.44 meters 

(300 feet)

RG-8X A/U 

(SEL-C964)

0.70 dB 3.50 dB 7.0 dB Unacceptable 

Loss

LMR-400 

(SEL-C966)

Do not use 1.95 dB 3.90 dB Unacceptable 

Loss

1/2-inch 

HELIAX

Do not use 1.15 dB 2.29 dB 6.87 dB

7/8-inch 

HELIAX

Do not use 0.64 dB 1.28 dB 3.84 dB
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Antenna System Ground

Antenna system grounding is not included in the scope of this manual. Please consult a 

radio systems engineer or other professional for advice on ground-system design. A 

well-designed system will minimize equipment damage and risk of electric shock to 

personnel.

Chassis Ground

Connect the grounding terminal labeled GND on the rear panel to a rack frame 

ground or main station ground for proper safety and performance. Use 4 mm2 

(12 AWG) or heavier wire less than 2 m (6.6 ft) in length for this connection. 

The ground connection should be made before the power connections.

Collocated Antenna Systems

Many radio systems today consist of having multiple radios at one location. The 

multiple radios are needed for either directed P2P links, multiple data needing to reach 

different locations, or for a primary/backup scheme. In these cases, it is desirable to 

install the antennas on the same pole or within close proximity to reduce cost. 

Installing multiple antennas in close proximity operating on the same frequency band 

can cause large amounts of adjacent channel interference. This adjacent interference 

can greatly degrade the availability and dependability of each link. Take the example of 

two P2P links where two of the antennas are at one location and the links terminate at 

two different locations (see Figure 2.3).

1-1/4-inch 

HELIAX

Do not use Do not use 0.95 dB 2.85 dB

1-5/8-inch 

HELIAX

Do not use Do not use 0.80 dB 2.4 dB

Table 2.5 Length vs. Loss in Coaxial Cables at 900 MHz (Sheet 2 of 2)

Cable Type
3.05 meters 

(10 feet)
12.24 meters 

(50 feet)
30.48 meters 

(100 feet)
91.44 meters 

(300 feet)
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Figure 2.3 Collocated Antennas With Two Radio Links

In this example the radio links generally will work but at the cost of link availability 

and dependability. Even though the radio links are using different hop sequences, there 

can still be significant levels of adjacent channel interference because of the difference 

between the transmitted power on one antenna and the receive power on the adjacent 

antenna. For example, Figure 2.3 displays two radio links with collocated antennas at 

Location A. If the antenna transmitting from Location A to C is transmitting at 36 dBm 

and at the same time the adjacent antenna on Radio A1 is receiving the signal from 

Location B at –70dBm, there is a 106 dBm signal difference between the two antennas. 

In this situation one will completely overpower the signal or greatly reduce the 

availability of the other. When radio transmit and receive timing cannot be coordinated 

to remedy this situation you need to either increase the distance separating the 

collocated antennas or use higher gain antennas that have narrower beams. The 

SEL-3031 has a better way to solve this problem by allowing collocated radios to 

synchronize their transmit and receive time slots and hop at exactly the same time. This 

will prevent the large signal difference from occurring and the collocated antennas can 

be placed within 2.4–3 m (8–10 ft) of each other. This technology is called SEL 

Hop-Sync™.

NOTE: If you have two or more synchronized radios and 
they lose synchronization the signal can be degraded to a 
point of loss of link. For mission critical applications make 
sure that the antennas are spaced far enough apart that 
if they lose synchronization that they will still operate 
with sufficient performance.

The radios are synchronized with one setting in each collocated radio and cabling 

between the radios. The radios use Pins 7 and 8 on Port 3 for synchronization. In this 

system you need to set each radio as a master. Set one radio to send the sync signal 

(SYNC SEND) and set the other radios to receive the sync signal (SYNC RECEIVE). 

If you have only two collocated radios you can use an SEL-C273A cable. This cable 

will have pins 7 and 8 sent between the radios that are crossed over. If you need to have 

more than 2 radios synchronized you will need to use cable SEL-C576. Figure 2.4 
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shows an example of how you would connect three collocated radios by using 

SEL-C576 cables along with BNC Tee and BNC coaxial cables. The BNC Tee and 

coaxial cables allow you to add more radios while utilizing one radio as the master 

sync radio (see Section 3: Job Done Examples).

 

Figure 2.4 Three Collocated Synchronized Radios

Installing Collocated Antennas

SEL Hop-Sync™ technology provides the ability to install multiple radios at one 

location and mitigate the interference typically seen from adjacent antenna links. SEL 

Hop-Sync technology allows you to place antennas within feet of each other and still 

maintain a strong signal link. If the application for using the radios with SEL Hop-

Sync technology is for non-critical data and the dependability is low then the antennas 

can be placed within 8–10 feet of each other and still provide proper operation.

The failure modes of the SEL Hop-Sync systems vary by application and by how many 

antennas are collocated. If you have a system with two collocated antennas using SEL 

Hop-Sync technology and one of the radios loses power then the system will still work 

properly. In the same condition, if you lose the synchronization cable between the two 

radios then they will interfere with each other and the radio signal will be degraded to 

the point of loss-of-link depending on the distance between radios. When using the 

radios in collocated applications with MIRRORED BITS or other critical 

communications, additional setup is needed to validate that if the radios become 

unsynchronized the radio links will still operate as expected with an acceptable level of 

dependability. Performing the following five steps helps to identify how far apart the 

antennas need to be to provide adequate link availability if synchronization is ever lost. 

This example follows the configuration shown on Figure 2.4.

Step 1. Setup the three locations as shown in Figure 2.3 and verify each link 

works independently.

Step 2. Leave the link from Radio A1 to B on and turn the power off on 

Radio A2 and C.
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Step 3. Interrogate Radio A1 and issue the RAD command to retrieve the 

RSSI (Receive Signal Strength Indication) value.

NOTE: Always do Step 2 on the link that is either the 
longest distance or has the worst RSSI value for the 
system.

Step 4. Turn off the power on Radio B. Turn on the power to ONLY Radio 

A1 and A2.

Step 5. Set the settings in Radio A2 to link with Radio A1. Interrogate Radio 

A1 and retrieve the RSSI. The difference between the RSSI value in 

Step 3 and Step 5 needs to be equal to or less than 24 dBm.

If the difference is greater than 24 dBm then move the antenna on A2 and repeat 

Step 5. If the antenna separation needed to achieve 24 dBm exceeds what is practical 

for installation, then try one or all of the items below to improve the adjacent 

interference.

You can achieve a higher availability with collocated antennas when unsynchronized 

by:

1. Reduce the transmit power on the collocated radio if the adjacent link 

has a much higher signal strength with adequate fade margin.

2. Change your SKIP settings on one radio so the radio pairs hop at a 

farther distance apart on the ISM band (see Radio Settings on 

page 4.12).

3. With two located antennas, polarize one radio opposite of the other.

NOTE: If you have two collocated links aimed to exactly 
same location then you should polarize both vertically.

4. Change out the collocated antennas with higher gain antennas with a 

narrower beam and lower side angle profile.
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Connections

Rear-Panel Connections

The physical layout of the SEL-3031 connections is shown in Figure 2.5.

Figure 2.5 Wall-Mount and Rack-Mount Rear Connections

Power Connections

The POWER terminals on the rear panel (labeled +/H and -/N) must connect to the 

correct supply voltage. The supply voltage range is located on the serial label. The 

wall-mount configuration accepts only 9–30 Vdc. The rack-mount configuration 

accepts 24–48 Vdc or 125/250 Vac or Vdc. Check the serial label for power supply 

information.

Do not apply power to the SEL-3031 without having a proper 50-  load on the antenna 

port. If you do not have the proper 50-  load connected, the radio antenna port will 

shut off, the alarm contact will pulse, and the ALARM LED will illuminate. This 

functionality protects the radio circuitry and indicates an antenna or cable failure. The 

POWER terminals on the rack-mount version are isolated from chassis ground. The 

POWER terminals on the wall-mount version are not isolated from chassis ground. Use 

2.5 mm2 (14 AWG) size wire to connect to the POWER terminals on the rack mount. 

Place an external circuit breaker or switch no more than 3 m (10 ft) from the 

equipment. The circuit breaker (or equivalent approved disconnect device appropriate 

for the country of installation) must comply with IEC 60947-1 and IEC 60947-3, be 

identified as the disconnect device for the equipment, and be located near the 

equipment. This disconnect device must interrupt both the hot (+/H) and the neutral 

(–/N) power leads. The maximum current rating for the power disconnect circuit 

breaker or overcurrent device (fuse) must be 20 A. An internal power supply fuse 

protects the operational power supply. Be sure to use fuses that comply with 

IEC 60127-2.
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Lightning Protection

WARNING
Atmospheric electrical charge accumulation can cause potential between the conductor and shield 
of the feedline, or cause lightning to strike an antenna. A lightning protector should be installed to 
prevent damage to equipment or injury to personnel.

Mounting the antenna on an equipment building roof or tower is safest because the 

potential rise on the outside of either of these structures will approximately equal the 

potential on the inside. A lightning protector (Radio Surge Protector, SEL part number 

200-2004) should be used to equalize the difference in potential that can occur between 

the center conductor and the shield of the coaxial cable between the antenna and the 

radio. The higher the antenna is mounted on a support structure, the greater the 

probability of equipment damage resulting from a lightning strike.

In all surge-protector applications, you should mount the surge protector at the building 

or enclosure entrance, and ground the surge-protector body. Ground the radio to the 

same point as the surge-protector ground to avoid ground-rise-potential damage. 

When using the surge protector, order an additional SEL-C964 or SEL-C966 cable and 

place this cable between the SEL-3031 and the surge protector. Because the distance 

varies from the SEL-3031 to the surge protector, be sure to specify this cable at 

approximately the correct length (plus 10 to 20 percent for installation variability).

Grounding (Earthing) Connections

You must connect the ground terminal labeled GND to a rack frame or 

switchgear ground for proper safety and performance. Use 2.5 mm2 (14 AWG) 

wire less than 2 m (6.6 ft) in length for the ground connection.

Serial Ports

Because all ports (1, 2, and 3) are independent, you can communicate to any 

combination simultaneously. All EIA-232 ports accept DB-9 male connectors. The 

serial port EIA-485 option for Port 1 is also a DB-9 male connector. If Port 1 is ordered 

with the EIA-485 option the product will ship with a DB-9-to-terminal adapter to 

easily wire to EIA-485 systems. Port 2 includes the IRIG-B time-code signal input (see 

Table 2.8). SEL offers fiber-optic transceivers or fiber-optic port options on Port 1 

(SEL-2812 and SEL-9220 compatible fiber-optic) for connecting devices at distances 

over 15 meters (50 feet) where copper cable is not appropriate. The SEL-2800 family 

of transceivers provides fiber-optic links between devices for electrical isolation and 

longer distances, overcoming the limitations of electrical EIA-232 interfaces. Contact 

SEL for further information on these products.
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Front-Panel Jumpers

The front panels of the rack- and wall-mount configurations contain two jumpers. 

Access to the jumpers is different for each configuration. Note that jumper number 1 

(JMP1) is for factory use only and should not be installed.

Wall-Mount Chassis Jumper Access

From the front of the wall-mount configuration, remove the four screws located on the 

sides of each corner. Use a Torx® T15 size screwdriver to remove the four screws. 

Slide the back cover up and to the back of the unit to reveal the front jumpers. You do 

not need to remove the ribbon cable to change jumpers. The jumpers are located to the 

left of the USB connector.

Rack-Mount Chassis Jumper Access

From the front of the rack-mount configuration, remove the front panel by loosening 

the six screws and removing the front panel. You will find the jumpers to the left of the 

USB connection.

Password Jumper

The SEL-3031 contains three levels of passwords to access and set the radio. The 

Level 1 password is for read access and the Level 2 password is for write access. The 

CAL level password moves from Access Level 2 to Access Level C (see Access 

Level C on page 4.19 for more information regarding the Access Level C). The default 

passwords that are shipped with the SEL-3031 are shown in Table 2.6. Do not leave 

factory-default passwords in the product. See PASSWORD Command on page 4.21 for 

more information on setting passwords. 

If necessary, you can disable passwords by installing a jumper. Refer to PASSWORD 

Command on page 4.21 for information on properly disabling and changing 

passwords. 

Table 2.6 Default Passwords

Access Level Password

1 OTTER

2 TAIL

CAL CLARKE
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IRIG-B Time-Code Input

The SEL-3031 accepts a demodulated IRIG-B time signal to synchronize the internal 

clock with an external time source. IRIG-B is available on Port 2 utilizing Pins 4 and 6 

for time communications. The SEL-3031 supports the IRIG-B002 standardized time 

format.

Front-Panel Indicators

The SEL-3031 has ten front-panel LED indicators. Table 2.9 further describes these 

indicators that display the current status of the radio. The LINK LED indicates when the 

SEL-3031 has properly connected to another SEL-3031. The SEC LED deals with the 

SEL-3044 Encryption Card. See Appendix B: Firmware Upgrade Instructions for more 

information on using this card.

Table 2.7 Password Jumper Position

Password Enable/Disable Jumper Position

Jumper Installed (Password Disabled)

The jumper installed disables the passwords.

Jumper Removed (Default) 

The SEL-3031 ships by default with passwords enabled.

Table 2.8 Communications Cables for Time and Communications Connections

EIA-232 Serial Port Connect to Device SEL Cable No.

Port 2 IRIG-B BNC with time only C256

SEL communications processors and com-

puting platform data with IRIG-Ba

a If connecting to an SEL communications processor you must turn the 5V_EN Global setting in 

the SEL-3031 to OFF.

C387

IRIG-B only from DB-9 on SEL-2407® C388
JM

P2
JM

P2
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Communications

Serial Ports

Table 2.10 shows the physical interfaces of the SEL-3031. Several options are provided 

for Port 1 physical interfaces, including EIA-232, EIA-485, and fiber.

Serial (EIA-232 and EIA-485)

Use the EIA-232 port for communications distances of 15.2 m (50 ft) in low-noise 

environments. Use the optional EIA-485 Port 1 for communications of 1200 m 

(3937 ft) maximum distance (to achieve this performance, ensure proper line 

termination at the receiver). 

If Port 1 is an EIA-485 connection, there are two types of connections that will work on 

multidrop systems. Table 2.11 shows the standard pinout of a recommended four-wire 

EIA-485 connection. If your system only works on a two-wire EIA-485 connection, 

then you will need to connect Pins 1 and 7 together and Pins 2 and 8 together. 

Figure 2.6 shows how to wire this configuration.

Table 2.9 Front-Panel Status Indicator LEDs

Label Color Description

ENABLE Green All self-tests are passing and unit is operational

ALARM Red ON: Self-test failure detected

Flashing: Antenna failure

SEC Green ON: Encryption card detected and wireless data secured

Flashing: Encryption card detected and in RESET

OFF: No encryption card present or card failed

LINK Green Communications link established between master and remote radio

TX 1, 2, 3 Green Serial data received by the port and transmitted out of the radio

RX 1, 2, 3 Red Radio data received and transmitting out of serial port

Table 2.10 SEL-3031 Port Description

Port Communications Interface Location

Port 1 EIA-232, EIA-485, or fiber Rear (Port 1 has three ordering options)

Port 2 EIA-232 Rear

Port 3 EIA-232 Rear

USB USB 1.1 Front (management port)
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Figure 2.6 SEL-C693 Cable: Two-Wire EIA-485 Connections

Fiber-Optic Serial Port

Order the fiber-optic option for Port 1 for safety and long-distance communications as 

far as 4 km (2.5 mi). The fiber-optic port is an SEL-2812-compatible device that can 

connect directly to any SEL-2812-compatible device or SEL-2812 Fiber-Optic 

Transceiver, using multimode fiber-optic cable with a core diameter of 50 to 200 m. 

When working with this device, observe the following safety precautions:

WARNING

➤ Do not look into the fiber (laser) ports/connectors.

➤ Do not look into the end of an optical cable connected to an optical 

output.

➤ Do not perform any procedures or adjustments that this instruction 

manual does not describe.

➤ During installation, maintenance, or testing of the optical ports, use 

only test equipment qualified for Class 1 laser products.

➤ Incorporated components, such as transceivers and laser emitters, are 

not user serviceable. Return units to SEL for repair or replacement.

Port Connector and Communications Cables

Figure 2.7 shows the EIA-232 and EIA-485 DB-9 connector pin numbering for the 

SEL-3031.

Figure 2.7 EIA-232 and EIA-485 DB-9 Connector Pin Numbers

Port 1 EIA-485
9-Pin Male
D Subconnector
2-Wire EIA-485

2-Wire EIA-485
Tinned Wires

1
7
2
8
5
5

Data+

Data-

GND
GND
No Connection

TXD+
RXD+
TXD–
RXD–
GND
GND

SHELL

Pin #

5  4  3  2  1

9  8  7  6
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Table 2.11 shows the pin function of the serial ports.

Cleaning

Use care when cleaning the SEL-3031. Perform the following steps:

Step 1. Use a mild soap or detergent solution and a damp cloth to clean the 

chassis.

Step 2. Be careful cleaning the front and rear panels because a permanent 

plastic sheet covers each panel.

Do not use abrasive materials, polishing compounds, or harsh chemical solvents (such 

as xylene or acetone) on any surface.

Table 2.11 SEL-3031 Port Description 

Pin
Port 1

EIA-232
Port 2

EIA-232
Port 3

EIA-232
Port 1

EIA-485

1 +5 Vdc +5 Vdc +5 Vdc TX+

2 RXD RXD RXD TX-

3 TXD TXD TXD N/C

4 N/C IRIG+ N/C N/C

5 GND GND GND GND

6 N/C IRIG– N/C N/C

7 RTS RTS SYNC IN RX+

8 CTS CTS SYNC OUT RX–

9 N/C N/C N/C N/C
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Cables

Figure 2.8 SEL-C245A Cable: SEL-3031 to Computer

Figure 2.9 SEL-C285 Cable: SEL-3031 to DTE Device (SEL Relays)

SEL-3031 

9-Pin Male
Subminiature "D" Connector

9-Pin Female
Subminiature "D" Connector

2
3
5
7
8

2
3
5
7
8

RXD
TXD
GND
RTS
CTS

RXD 
TXD 
GND
RTS 
CTS 

Pin
Func.

Pin
Func.Pin # Pin #

PC Device

NOTE: For best results, limit the cable length to 15 m (~50 ft)

ORANGE
RED

BLUE/SHIELD
GREEN
WHITE

SEL-3031 

9-Pin Male
Subminiature "D" Connector

No IRIG
9-Pin Male
Subminiature "D" Connector

2
3
5
7
8

2
3
5
7
8

RXD
TXD
GND
RTS
CTS

Pin
Func. Pin # Pin #

DTE Device

NOTE: For best results, limit the cable length to 15 m (~50 ft)

ORANGE
RED

BLUE/SHIELD
GREEN
WHITE
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CAUTION
You must turn off the +5 V on Pin 1 of the SEL-3031 when connecting to a communications processor.

Figure 2.10 SEL-C387 Cable: SEL-3031 to SEL Communications Processor 
With IRIG-B

Figure 2.11 SEL-C273A Cable: SEL-3031 Repeater and Synchronizing Cable

SEL-3031 

9-Pin Male
Subminiature "D" Connector

With IRIG
9-Pin Male
Subminiature "D" Connector

1
2
3
4
5
6
7
8
9

1
2
3
4
5
6
7
8
9

Pin # Pin #

NOTE: For best results, limit the cable length to 15 m (~50 ft)

SEL Communications Processor

SEL-3031 

9-Pin Male
"D" SUB CONNECTOR
DB-9-P

9-Pin Male
"D" SUB CONNECTOR
DB-9-P

2
3
5
7
8

3
2
5
8
7

RXD
TXD
GND

SYNC IN
SYNC OUT

SHELL

Pin
Func.

RXD
TXD
GND
SYNC IN
SYNC OUT
NO CONNECTION

Pin
Func.Pin # Pin #

SEL-3031 

CABLE:  9 Conductor 22 AWG 7/30 Tinned Copper with PVC Jacket
             (Shielded:  Alpha 1298C or equal; Unshielded:  Alpha 1179 or equal)

ORANGE
RED

BLUE/SHIELD
GREEN
WHITE
SHIELD
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Figure 2.12 SEL-C576 Cable: Synchronizing Cable for SEL-3031

USB Interface

The SEL-3031 uses a standard USB Type-B interface for the management port. The 

USB interface is used for settings management, initial radio installation, and reporting 

data from long-term radio statistics. The management port may be used while the 

SEL-3031 is in service without disrupting the radio communications. To use this 

interface, plug a USB Type-B cable into the radio and plug the other end into your PC. 

This will automatically prompt your PC to install a USB-to-serial driver that creates a 

virtual serial port. The virtual serial port needs to be set to 9600 bps, 8 data bits, 1 stop 

bit, and no parity to properly communicate with the SEL-3031. This virtual serial port 

can now be used with ACSELERATOR QuickSet® SEL-5030 Software to help set and 

view settings and obtain report information.

Figure 2.13 USB Interface

SEL-3031 

9-Pin Male
Subminiature "D" Connector

9-Pin Female
Subminiature "D" Connector

1
2
3
5

1
2
3
5

+5Vdc
RXD
TXD
GND

Pin
Func.

+5Vdc
RXD
TXD
GND

Pin
Func.Pin # Pin #

BNC Jack Connectors

SYNC IN/OUT

DTE Device

NOTE:  For best results, limit the cable length to 15 m (~50 ft)

BROWN
ORANGE

RED
SHIELD

7
5
8

SYNC IN
GND

SYNC OUT

CENTER
SHIELD
CENTER
SHIELD

BLUE
BLACK
WHITE

SYNC IN

SYNC OUT

SEL-3031
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Section 3
Job Done Examples

Overview

This section has four job done examples of how to easily set up the SEL-3031 for 

common applications. This section assumes you have established a radio link. If you 

are having problems setting up the radio link, refer to Section 2: Installation and 

Section 5: Performance Monitoring, Testing, and Troubleshooting for more 

information.

This section contains four Job Done examples for the following applications.

➤ High-Speed Teleprotection or Control With MIRRORED BITS 

Communications

➤ Using an SEL Information Processor to Collect Relay Status and 

Measurements

➤ Setting Up a Point-to-Multipoint Link Using DNP3 SCADA Protocol

➤ Configuring Collocated Antennas Using SEL Hop-Sync Technology 

High-Speed Teleprotection or Control With 
MIRRORED BITS Communications

Figure 3.1 SEL MIRRORED BITS Connection Example

SEL-351

SEL-2505

SEL-2100

SEL-3031SEL-3031
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3.2

The SEL-3031 can handle as many as three connections of MIRRORED BITS® 

simultaneously over one radio link. For this example, there are three MIRRORED BITS 

channels over the SEL-3031. This example shows you how to set the radio and set 

different end devices to properly use the radio as a MIRRORED BITS link.

SEL-3031 MIRRORED BITS Settings

For Figure 3.2, we set Port 1 on both SEL-3031 devices as a MIRRORED BITS 

connections.

On each radio, set the following settings on the Port 1 settings.

Figure 3.2 SEL-3031 Port Settings for MIRRORED BITS Connection

The SEL-3031 makes it very simple to set a MIRRORED BITS connection. Set the 

PROTO setting to MB8 to make it a MIRRORED BITS port. The SEL-3031 without an 

encryption card has data rate of 9600, 19200, or 38400 bps (8, N, 1). Setting the speed 

to 38400 provides the lowest latency at the cost of disabling Port 2. Port 3 can still be 

used for data at 9600 or 19200 bps speeds.

On Port 1 on each radio, install an SEL-C285 cable to the IED device. As an 

alternative, the SEL-3031 can be ordered with a fiber-optic serial port that works with 

SEL-2812 transceivers. If you use the fiber-optic port on the SEL-3031, the IED 

connection needs to be an SEL-2812MR Fiber-Optic Transceiver.

Preliminary Copy—Subject to Change



Date Code 20181001 SEL-3031 Instruction Manual

Job Done Examples

High-Speed Teleprotection or Control With MIRRORED BITS Communications

3.3

SEL-351, SEL-311, and SEL-700 Series MIRRORED BITS Settings

The required settings for the SEL-351 are shown below. These settings are similar to 

all of the SEL-351, SEL-311, and SEL-700 series of relays. To establish a 

communications link via the radio, the most critical settings are PROTO, SPEED, 

RTSCTS, RXID, and TXID.

=>SHO P 2 <Enter>

Port 2

PROTO = MB8A

SPEED = 19200    RTSCTS= N      RBADPU= 60       CBADPU= 1000

RXID  = 1        TXID  = 2      RXDFLT=XXXXXXXX

RMB1PU= 1        RMB1DO= 1      RMB2PU- 1        RMB2DO= 1

RMB3PU= 1        RMB3DO= 1      RMB4PU- 1        RMB4DO= 1

RMB5PU= 1        RMB5DO= 1      RMB6PU- 1        RMB6DO= 1

RMB7PU= 1        RMB7DO= 1      RMB8PU- 1        RMB8DO= 1

Figure 3.3 SEL-351 Port Settings for MIRRORED BITS Connection

The SEL-3031 allows you to set Port 1 to 9600, 19200, or 38400 bps (8, N, 1). If the 

SEL-3044 Encryption Card is used, the data rate changes to 9600 or 19200 bps 

(8, N, 1).

Set PROTO equal to MB8x, where x equals A or B depending on which MIRRORED 

BITS channel is used.

NOTE: This setting is slightly different in the SEL-2100 Logic 
Processor, SEL-3530 Real-Time Automation Controller 
(RTAC), and SEL-321 Relay. 

Set SPEED equal to 9600, 19200, or 38400 bps (or 9600/19200 if the encryption card 

is installed).

Set RTSCTS (hardware handshaking) to N to disable that option. 

Set the RXID equal to one and TXID equal to two at the master end. At the remote end, 

set the RXID equal to two and the TXID equal to one. The relays use these addresses to 

prevent a relay from receiving messages from a secondary MIRRORED BITS device if 

the paths are accidentally connected wrong. The relay only receives messages sent by a 

relay with the matching transmit address and vice versa. 

To connect the relay to the radio, use an SEL-C285 cable (DB-9 male-to-DB-9 male 

straight-through). If complete electrical isolation is desired between the radio and a 

relay EIA-232 communications port, use the SEL-2812MR Fiber-Optic Transceiver 

and fiber-optic cable to connect the relay to the radio. 
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SEL-400 Series MIRRORED BITS Settings

The required port settings for SEL-400 series relays are shown below. To establish 

communication via the radio, the most critical settings are PROTO, MBT, SPEED, 

STOPBIT, TXID, RXID, and TXMODE. All other settings are per the application 

requirements.

Protocol Selection

PROTO := MBA

Communications Settings

MBT := N SPEED :=19200 STOPBIT := 2

Mirrored Bits Protocol Setting

TX_ID := 2 RX_ID := 1 RBADPU := 10 CBADPU := 20000

TXMODE := P MBNUM := 8 RMB1FL := P RMB1PU := 1

RMB1DO := 1 RMB2FL := P RMB2PU := 1 RMB2DO := 1

RMB3FL := P RMB3PU := 1 RMB3DO := 1 RMB4FL := P

RMB4PU := 1 RMB4DO := 1 RMB5FL := P RMB5PU := 1

RMB5DO := 1 RMB6FL := P RMB6PU := 1 RMB6DO := 1

RMB7FL := P RMB7PU := 1 RMB7DO := 1 RMB8FL := P

RMB8PU := 1 RMB8DO := 1

Figure 3.4 SEL-451 Port Settings for MIRRORED BITS Connection

Set PROTO equal to MBx, where x equals A or B depending on which MIRRORED BITS 

channel is being used. Set MBT equal to N to disable that option. 

Set SPEED equal to 19200 (or 9600 if the encryption card is installed). 

Set STOPBIT equal to 2.

NOTE: If you are using the SEL-3044 Encryption Card, you 
must change the connected devices’ RMBxPU and 
RMBxDO settings = 2 to maintain the same level of 
channel security as the standard MB8 protocol. This will 
delay operation by one processing interval but will give 
you a higher level of channel security.

Set the RXID equal to one and TXID equal to two at the master end. At the remote end, 

set the RXID equal to two and the TXID equal to one. The relays use these addresses 

so that the master relay only receives messages sent by a relay with the matching 

transmit address and vice versa. 

Set TXMODE equal to P (Paced). 

To connect the relay to the radio, use an SEL-C285 cable (DB-9 male-to-DB-9 male 

straight-through). If complete electrical isolation is desired between the radio and 

antenna and the EIA-232 communications port of the relay, use the SEL-2812MR 

Fiber-Optic Transceiver and fiber-optic cable to connect the relay to the radio.
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3.5

SEL-2505 and SEL-2506 Settings

The SEL-2505 and SEL-2506 use control (DIP) switches to set the MIRRORED BITS 

connection. For easy installation order the SEL-2505 with the SEL-2812 fiber-optic 

option (SEL-2505x6xXX). Use multimode SEL-C808 or SEL-C807 ST terminated 

fiber-optic cable to directly connect the SEL-2505 to an SEL-3031 equipped with a 

fiber-optic option for Port 1. Other transceiver models can be used as long as the 

corresponding SEL-2800 family transceiver is used on both ends.

Figure 3.5 SEL-2505 DIP Switch Settings for MIRRORED BITS Connection

Set the TX_ADD equal to one and set RX_ADD equal to two at the local end. At the 

remote end, set the RXID equal to two and the TXID equal to one. The devices use 

these addresses so that the master relay only receives messages sent by a relay with the 

matching transmit address and vice versa. 

Set Switch 9 and 10 equal to MB8/9600, MB8/19200, or MB8/38400 for the 

Protocol/Baud setting. If the SEL-3031 contains the SEL-3044 Encryption Card then 

the Protocol/Baud setting must be MB8/9600 or MB8/19200.

To connect the SEL-2505 to the radio, use a 62.5 µm multimode SEL-C808 or 

SEL-C807 fiber-optic cable. Order these cables equipped with ST® connectors and 

your choice of zipcord or waterproof heavy-duty jacketed fibers.

Initial Checkout

An easy way to verify that the relays are communicating is to use the TARget 

command, as shown below.

=>TAR ROKA <Enter>

LBOKB CBADB RBADB ROKB LBOKA CBADA RBADA ROKA

0 0 0 0 0 0 0 1

Figure 3.6 TAR ROKA Command From an SEL-351

The results shown here are from an SEL-351 Relay. ROKA is asserted, meaning that 

the two relays have established MIRRORED BITS communication. For longer-term 

channel tests, use the COM report command available in the relay and suggestions 

described in Monitoring Radio Performance on page 5.1.
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3.6

Using an SEL Information Processor to 
Collect Relay Status and Measurements

SEL information processors and computing platforms easily collect relay status and 

measurement information. SEL information processors include the SEL-3530 Real-

Time Automation Controller, SEL-2032, SEL-2030, and SEL-2020 Communications 

Processors, and ruggedized SEL computers configured as intelligent servers or 

gateways. An SEL information processor can be used as a data collection point, port 

switch, and to control operations all through one serial port. The SEL-3031 serial 

interface allows you to obtain all of this relay information from remote IEDs through 

the use of the wireless connection. The example below will show you how to set the 

radio, relays, and communications processors to allow the Fast Messaging protocol to 

operate over a wireless connection.

Figure 3.7 SEL-3031 Linking Information Processors to Relays

SEL-3031 Settings

The SEL-3031 requires very few inputs for setting up the serial port to the correct 

protocol. Figure 3.8 shows the settings needed for Port 1.

SEL-351

SEL-3031SEL-3031

SEL-2032

SEL-451
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3.7

Figure 3.8 SEL-3031 Port 1 Settings for Fast Messaging

The PROTO setting must be set to Standard. The Standard setting is the default for 

use on any byte-oriented protocol. The Standard setting is used with connections such 

as DNP3, SEL ASCII, Compressed ASCII, Fast Operate, Fast SER, and SEL Fast 

Meter with Configuration.

The ARQ setting should be set to Y. This allows data retransmission when an error is 

detected. The SPEED setting can be set 9600, 19200, or 38400 bps. If you set it to 

38400, it will disable Port 2. Port 3 will still operate at 9600 or 19200 bps. The CTS1 

setting should be set to Deasserted. This will deassert the control lines on the 

SEL-3031. Some protocols in devices require the control line to be in a high or low 

state to permit proper communication. For example, with DNP3, some remote devices 

will not reply back to the master until the control line is deasserted. If the control line is 

asserted the DNP3 device is told to wait. Again, this setting is based upon how the 

vendor implemented flow control in the devices. For most all SEL products this setting 

should always be set to Deasserted.

On Port 1 of each radio, install an SEL-C285 cable to the IED. As an alternative, the 

SEL-3031 can be ordered with a fiber-optic serial port that works with SEL-2812 

transceivers. If you use the fiber port on the SEL-3031, the connection at the IED needs 

to be an SEL-2812MR transceiver or compatible built-in port.
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SEL-300 Series Settings

The required settings for the SEL-351 are shown in Figure 3.9. These settings are 

similar to all of the SEL-351, SEL-311, and SEL-700 series of relays. To establish a 

communications link via the radio, the most critical settings are PROTO, SPEED, 

BITS, PARITY, STOP, and RTSCTS.

=>>SHO P 2 <Enter>

Port 2

PROTO = SEL      

SPEED = 19200    BITS  = 8        PARITY= N        STOP  = 1        

T_OUT = 10       AUTO  = Y        RTSCTS= N        FASTOP= Y        

=>>

Figure 3.9 SEL-351 Port Settings for Fast Messaging

Set AUTO = Y if you want the relay to send automatic messages to indicate specific 

conditions.

Set FASTOP = Y if you want the communications processor to issue control 

commands to the relay.

SEL-2032/SEL-2030 Settings

The following steps demonstrate on how to set SEL-2032 to initially connect and 

configure an SEL-351 Relay.

Step 1. Use the SEL-C285 cable to connect one of the SEL-2032 ports; this 

example uses Port 2 to Port 1 of the SEL-3031.

Step 2. Enter Access Level 2 on the SEL-2032 and issue the SET P 2 

command to configure Port 2. The SEL-2032 prompts for the type of 

device connected to the port. 

a. Enter S for the SEL IED.

b. Enter Y to autoconfigure the port.

c. Press the <Enter> key to confirm the configuration prompts.

The SEL-2032 establishes communication with the relay; 

determines the type of relay, relay ID, and communications 

data rate; and determines if the relay is capable of Fast Meter. 

d. Enter Y to save port configuration changes at the final 

prompt.

Step 3. Issue the AUTO 2 command to see what Fast Message features are 

supported by the SEL-351S. Figure 3.10 shows an example output for 

the AUTO command.
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*>>AUTO 2 <Enter>

FID: FID=SEL-351S-7-R106-V0-Z003003-D20010110

DEVICE ID: FEEDER 1

BAUD RATE: 19200

OPERATE SUPPORT: Binary (1 Breakers, 16 Remote Bits S-C-P)

LEVEL 1 PASSWORD: OTTER

COMMANDS SUPPORTED:

B 20METER

B 20DEMAND

B 20TARGET

A 20HISTORY

A 20STATUS

A 20EVENT

A 20EVENTS

A 20EVENTL

*>>

Figure 3.10 Example AUTO Command Output

The AUTO command verifies initial configuration is set up. Refer to the SEL-2032 

Instruction Manual for more information on setting up Fast Messaging.
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Setting Up a Point-to-Multipoint Link Using 
DNP3 SCADA Protocol

Figure 3.11 SEL-3031 Point-to-Multipoint Example

The SEL-3031 is designed to work in P2P (Point-to-Point) and P2MP (Point-to-

Multipoint) modes. In P2MP mode Port 1 is the only active port. Port 2 and Port 3 are 

disabled in this mode. This example will show how to setup a P2MP radio connection 

where there is one radio at the master location connected to an SEL-3530 RTAC and 

the other end will be three or more remote radios connected to SEL-651R recloser 

controls. The protocol used in this example is DNP3. In P2MP mode, the radio works 

with most multidrop addressable protocols, including MODBUS.

The radios set in P2MP mode operate by allowing the master to send information to all 

of the remotes. Only the remote that is connected to the IED (SEL-651R) with the 

correct SCADA address will respond back to the master. Data will collide if the remote 

is not set up correctly where two remotes share the same address or sending unsolicited 

data. All remote radios have the ability to transmit data to the master and the protocol 

addressing determines which remote should respond to the master.
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SEL-3031 Settings

The SEL-3031 requires very few settings to set up the radios. This example assumes 

the radios have been set up and are currently linked. You should use an SEL-C285 

cable to connect the SEL-3031 to the SEL-3530 RTAC and SEL-651R. If you are 

having problems setting up the radio link, refer to Section 2: Installation and Section 5: 

Performance Monitoring, Testing, and Troubleshooting for more information.

Figure 3.12 Radio Settings for Point-to-Multipoint

In the Radio Settings, the NETARCH setting must be set to P2MP. The P2MP mode 

disables Port 2 and Port 3 and allows multiple remote radios to connect to one master.

The MODE setting must be set to MASTER for the radio located at the master location 

connected to the RTAC. All of the remote radios must have this setting set as 

REMOTE.

The rest of the Radio Settings can be left to default. 

NOTE: You must set the TXPWR correctly to stay in 
compliance with the FCC and IC with a maximum allowed 
36 dBm EIRP transmitted signal. See Transmitted Signal 
on page 2.3 for more information.
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Figure 3.13 Port 1 Settings for Point-to-Multipoint

Figure 3.13 shows the correct settings needed for creating a DNP channel for P2MP. 

The PROTO setting should be set to STANDARD. Setting the PROTO to Standard 

allows all byte-oriented multidrop protocols to pass through the port. If using 

MODBUS then set PROTO to MODBUS. 

Leave the ARQ setting to Y. In P2MP mode this allows the message being sent from 

the remote to the master to retransmit on error. In P2MP mode this will not allow the 

master transmit message to retransmit on error.

The SPEED setting can be set for 9600, 19200, or 38400 bps. It is preferred to set this 

to 38400 to take advantage of higher throughput to reduce the overall polling time. If 

any of the end devices do not support 38400 then the whole system must be set down to 

9600 or 19200 bps.

The CTS State should be set to DEASSERTED by default. Setting to deasserted allows 

proper communication with most SEL devices. If the remote device is not responding 

to DNP messages then this setting may need to get set to ASSERTED. Most DNP 

devices look at the CTS line and will not send the DNP message unless the CTS line is 

in an asserted or deasserted state. This setting allows you to set the line high or low to 

always give the device permission to transmit. 

SEL-3530 RTAC Settings

To properly set the RTAC it is best to review the SEL-3530 manual under Section 4: 

DNP3. This section explains how to setup a DNP3 connection.
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Figure 3.14 SEL-3530 RTAC DNP3 Settings

Once a DNP port is set on the RTAC to a “Client-Multidrop Serial“ a list of settings are 

shown in Figure 3.14. One of these devices must be set for each remote SEL-651R on 

the system. The Client DNP Address in the example is set to 1000. This is the address 

of the RTAC DNP master. All devices set up on the RTAC must be set to communicate 

to the same master address. Similarly on the SEL-651R all settings for REPADR 

should be set to 1000.

The Server DNP Address is the address of the remote SEL-651R device. Each RTAC 

device must have a unique address. The corresponding DNPADR in the SEL-651R 

must be set to the same corresponding device.

The Integrity Poll and Class polling should be set such that there is enough time to poll 

all remote devices in the allocated time. The more remote devices that are in a system 

the longer time is needed for the polling.

The Number of Poll Retries in this example is set to 5. Given the availability of the 

radio system will change this setting. If the SEL-3031 has a greater than 95 percent 

availability and the ARQ in the radio is turned on then you would not expect to see 

many poll retries.

The Baud Rate should be set to 38400 to match the system baud rate. The rest of the 

settings are either fixed or you can leave as default.
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SEL-651R Settings

Figure 3.15 SEL-651R Communications Settings for P2MP

The SEL-651R has a minimum of four settings to get the link up and running. There 

are more settings to determine types and mapping of digital and analog data but are not 

needed to verify initial operation. This example only demonstrates on how to get the 

RTAC communicating to the SEL-651R through the SEL-3031 in P2MP mode.

Figure 3.15 shows the first setting needed in the SEL-651R. The settings are needed in 

all remote SEL-651R units communicating to the RTAC. The PROTO needs to be set 

to DNP for the current protocol used. The SPEED needs to be set to 38400 to match the 

system baud rate. The rest of the settings in this group can be left as default.

Figure 3.16 shows the settings for the DNP port set in the SEL-651R.
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Figure 3.16 SEL-651R DNP Port Settings for P2MP

The DNPADR is set to 100 in this example. Each remote SEL-651R must be set to a 

unique address. This corresponding address must match the RTAC device address 

called “Server DNP Address“.

The REPADR is set to 1000 in this example. This is the address the SEL-651R is to 

report back to, otherwise called the master address. All remote SEL-651R units should 

be set to the same master address. All the other settings can be left as default and are 

not needed for initial configuration. If a different type or class of event data is needed, 

then more of these settings need to be changed along with settings in the RTAC. This is 

not covered under the scope of this example.

Verifying Proper Operation

Once all the settings in the SEL-3031 radios, RTAC, and SEL-651R are set correctly, 

the next step is to verify proper operation. Easily check this by looking at the master 

SEL-3031 Tx and Rx LEDs on Port 1. If the Tx LED illuminates, and the Rx LED 

illuminates shortly after, the link is up and working. If you only see the Tx LED 

illuminate and not the Rx LED illuminate you either have a problem with the settings 

in the radio, settings problem on the SEL-651R, or you are using the wrong cable. You 

can also review the data LED at each remote location. These LEDs will help 

troubleshoot the problem. If you do not see the Tx LED on the master radio 

illuminating then you are either using the wrong cable or do not have the correct 

settings in the RTAC.
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Configuring Collocated Antennas Using 
SEL Hop-Sync Technology

There are radio applications that require multiple links at one location. Using multiple 

antennas at one location operating at the same frequency band causes interference 

issues with adjacent placed antennas. To improve the dependability when using 

collocated antennas the radio comes with SEL Hop-Sync™ technology. SEL Hop-Sync 

technology allows you to connect collocated antennas together and synchronizes all the 

radios connected so they hop at the exact same time. This greatly reduces adjacent 

channel noise and allows each radio to receive data without interference from the 

adjacent antennas.

There are three applications where collocated antennas are typically applied.

1. Setting up a repeater location where two back-to-back radios are 

used.

2. Setting up two links going to and from the same location as a 

primary/backup radio installation.

3. Creating two or more links from a central location going to separate 

locations.

This example will show how to set up collocated antennas in a repeater location using 

MIRRORED BITS. Once you understand how to setup up collocated antennas 

applications 2 and 3 can be easily extrapolated. See Collocated Antenna Systems on 

page 2.8 for more information.

 

Figure 3.17 Setting up Collocated Antennas at a Repeater Location

Figure 3.17 is the connection diagram with the cables and antennas needed for this 

application. This example uses two SEL-311C relays communicating MIRRORED BITS 

over the radio link. The line of site between location 1 and 2 is obstructed by a hill. A 

repeater location is set up to transmit around the hill.
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SEL-311C and SEL-3031 Settings at Location 1 and 2

The SEL-311C serial port needs to be set to MB8 MIRRORED BITS protocol. Follow the 

job done Example 1 to configure the SEL-311C and the SEL-3031 radios located at 

Location 1 and Location 2.

SEL-3031 Settings at Repeater Location

Set the two collocated SEL-3031 radios at the repeater location with settings similar to 

the radios at Location 1 and 2. Set the radio at the Repeater location that is 

communicating to Location 1 the same as the setting of the SEL-3031 at Location 2. 

Do the same for SEL-3031 at the Repeater location communicating to Location 2 set 

the same as the SEL-3031 at Location 1. This setup will start as two independent P2P 

links. At the repeater location use an SEL-273A cable to connect Port 1 on each radio. 

This setup should allow the repeater link to pass information to the next radio and the 

relays should be communicating MIRRORED BITS. This link will work adequately if the 

repeater antennas are placed far enough apart to prevent the adjacent antenna from 

interfering. To improve this link and to allow the antennas to be placed closer you will 

need to synchronize the radios.

Synchronizing the Radios at the Repeater Location

To synchronize the system we need to synchronize the radios at the repeater location so 

that the collocated radios transmit and receive at the same time. To do this you must 

connect an SEL-273A cable between Port 3 of the radios at the repeater location. The 

radios will use Pin 7 and Pin 8 in the communications cable to synchronize each other. 

The last step to synchronizing radios is to set the SYNC setting in each of the radios at 

the repeater location. You must make one radio the master SYNC SEND and the other 

a master SYNC RECEIVE.
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Figure 3.18 SYNC Settings for Master Radio

Figure 3.18 shows the settings for the master radio at the Repeater location. The SYNC 

setting for this device must be set to SEND. This tells the radio to generate a pulse to 

synchronize connected radios. On the second master radio at the Repeater location you 

must set SYNC to RECEIVE.
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PC Software

ACSELERATOR QuickSet® SEL-5030 Software is a powerful settings and HMI tool 

that aids in setting, applying, and using the SEL-3031 and other SEL devices. This 

section describes how to get started with your SEL-3031 and QuickSet.

Setup

Follow the steps outlined in Section 2: Installation to prepare the SEL-3031 for use. 

Perform the following steps to initiate communications:

Step 1. Apply power to the SEL-3031.

Step 2. Connect a USB Type-B cable (SEL-C664) between the management 

port of the SEL-3031 and the PC.

Step 3. Follow the on screen instructions and install the USB driver if not 

already installed.

Step 4. Start QuickSet.

Table 4.1 ACSELERATOR QuickSet SEL-5030 Software

Terminal Provides a direct connection to the SEL device. Use this com-

munications method to interface directly with the device.

Rules-Based Settings 

Editor

Provides online or offline device settings that include 

interdependency checks. Use this feature to create and 

manage settings for multiple devices in a database.

Settings Database 

Management

Provides a database to manage multiple device settings.

Help Provides general QuickSet and device-specific QuickSet con-

text help.
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Communications

QuickSet uses the device USB management port to communicate with the SEL-3031. 

Perform the following steps to configure QuickSet to communicate effectively with the 

device.

Step 1. Click Communications from the QuickSet main menu bar, as shown 

in Figure 4.1.

Figure 4.1 Communications Menu

Step 2. Select Parameters to display the screen shown in Figure 4.2.
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Figure 4.2 Serial Port Communications Parameters

Step 3. Configure the PC port to Data Speed 9600, Data Bits 8, Stop Bits 1, 

and Parity None.

Step 4. Configure QuickSet to match the SEL-3031 default settings by 

entering the Access Level 1 and Access Level 2 passwords in their 

respective text boxes.

Step 5. Exit the menus by clicking OK when finished.

Terminal Window

Select Communications > Terminal on the QuickSet main menu bar to open the 

terminal window (shown in Figure 4.3).
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Figure 4.3 Terminal Window Menu

The terminal window is an ASCII interface for the device that supports a basic terminal 

emulation. Open the terminal window by clicking Communications > Terminal or by 

typing <Ctrl+T>. Verify proper communications with the device by opening a 

terminal window, pressing <Enter> a few times, and verifying that a prompt is 

received. If a prompt is not received, verify proper setup.

Drivers and Part Number

After clicking Communications > Terminal, access the device at Access Level 1. 

Issue the ID command to receive an identification report, as shown in Figure 4.4.

=>>ID <Enter>

"FID=SEL-3031-R100-V0-Z001001-D20091009","08DC"

"BFID=SLBT-3031-R100-V0-Z001000-D20091009","0965"

"CID=25DC8978","034B"

"DEVID=STATION_A","04DB"

"DEVCODE=72","0310"

"PARTNO=30310W01XXX","0538"

"CONFIG=00000000","03E3"

"SPECIAL=0”,”02DE”

=>>

Figure 4.4 Device Response to ID Command

Locate and record the Z-number (Z001001) in the FID string. The first portion of the 

Z-number (Z001...) determines the QuickSet device settings driver version when you 

are creating or editing device settings files. The Device Editor driver will be discussed 

in more detail in Device Editor (Editor Mode). Compare the part number (PARTNO = 

3031XXXXXXX) with the Model Option Table (MOT) to ensure correct device 

configuration.
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Settings

Settings Database Management and Drivers

QuickSet uses a database on the PC to save device settings. QuickSet contains sets of 

all settings files for each device specified in the Database Manager. Choose appropriate 

storage backup methods and a secure location for storing database files.

Active Database

Change the active database to the one requiring modification by selecting File > Active 

Database on the main menu bar.

Database Manager

Select File > Database Manager on the main menu bar to create new databases and 

manage records within existing databases.

Settings Database
Step 1. Open the Database Manager to access the database. Click File > 

Database Manager. A dialog box will appear. The default file 

already configured in QuickSet is Relay.rdb. This database contains 

example settings files for the SEL products with which you can use 

QuickSet.

Step 2. Enter descriptions of the database for each device in the Database 

Description and Settings Description dialog boxes.

Step 3. Enter special operating characteristics that describe the device 

settings in the Settings Description dialog box. These can include 

radio location and communications settings.

Step 4. Highlight one of the devices listed in Settings in Database and click 

Copy to create a new collection of settings. QuickSet will prompt for 

a new name. Be sure to enter a new description in the Settings 

Description.

Copy/Move Settings Between Databases
Step 1. Select Copy/Move Settings Between Databases to create multiple 

databases with the Database Manager.

These databases are useful for grouping similar protection schemes or 

geographic areas.

Step 2. Click Open B to open a device database.

Preliminary Copy—Subject to Change



SEL-3031 Instruction Manual Date Code 20181001

Settings and Commands

Settings

4.6

Step 3. Type the filename and click Open.

a. Highlight the device or setting in the A database.

b. Select Copy or Move, and click the > button to create a new 

device or setting in the B database.

Step 4. Reverse this process to take devices from the B database to the A 

database. Copy creates an identical device that appears in both 

databases. Move removes the device from one database and places 

the device in another database.

Create a New Database/Copy an Existing Database

To create a new database, perform the following:

Step 1. Open File > Database Manager and click Create New Database. 

QuickSet will prompt you for a file name.

Step 2. Type the new database name (and location if it differs from the 

previous database location), and click Save. QuickSet displays the 

message Settings [path and file name] was 

successfully created.

Step 3. Click OK.

To copy an existing database of devices to a new database, perform the following:

Step 1. Open File > Database Manager and click Copy/Move Settings 

Between Databases in the Database Manager dialog box. QuickSet 

will open the last active database and assign it as Database A.

Step 2. Click Open B. QuickSet will prompt you for a file location. Type the 

new database name, click Open, and click Yes. The program will 

then create an empty database. Load devices into the new database as 

shown in Copy/Move Settings Between Databases.

Settings

QuickSet allows you to create settings for one or more SEL-3031 devices. Store 

existing device settings downloaded from the SEL-3031 by creating a library of 

settings, then modify and upload these settings from the library to an SEL-3031. 

QuickSet makes setting the device easy and efficient and provides rules-based settings 

checks, commissioning, and help.

Settings Editor

The Settings Editor shows device settings in easy-to-understand categories. and makes 

setting the device simple and efficient. Settings are grouped logically, and settings that 

are not used in the selected group are dimmed (grayed) in the QuickSet menus. 
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QuickSet shows all of the settings categories in the settings tree view. The settings tree 

view remains constant whether settings categories are enabled or disabled. However, 

any disabled settings are dimmed when accessed by clicking an item in the tree view.

File Menu

QuickSet uses a database to store and manage SEL device settings. Each unique device 

has its own record of settings. Use the File menu to open an existing record, create and 

open a new record, read device settings, create an open a new record, or convert and 

open an existing record. This record can be opened in the Settings Editor as a Setting 

Form (template) or in Editor Mode.

File > New

Select File > New to command new settings files. QuickSet will create the new settings 

files from a driver that you specify in the Settings Editor Selection dialog box. 

QuickSet uses the Z-number in the FID string to create a particular version of settings. 

To get started, select File > New from the main menu bar, then select SEL-3031 and 

001 from the Settings Editor Selection window as shown in Figure 4.5.

Figure 4.5 Selection of Drivers

After you select the device model and settings driver, QuickSet will present the Device 

Part Number dialog box. Use this dialog box to configure the Device Editor to produce 

settings for your device with options determined by the part number, as shown in 

Figure 4.6. Click OK when finished.
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Figure 4.6 Update Part Number

Figure 4.6 shows the Settings Editor screen. View the bottom of the Device Editor 

window to verify the Settings Driver number. Compare the QuickSet Settings Driver 

number and the first portion of the Z-number in the FID string (this can be found by 

selecting Tools > HMI > HMI > Status). These numbers must match. QuickSet uses 

the first portion of the Z-number to determine which Device Editor to display.

Figure 4.7 New Setting Screen

File > Open

Select File > Open to open an existing device from the active database folder. 

QuickSet prompts for a device to load into the Device Editor.
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File > Read

Select File > Read to cause QuickSet to read the device settings from a connected 

device. As QuickSet reads the device, a Transfer Status window will appear. QuickSet 

uses serial protocols to read settings from SEL devices.

Device Editor (Editor Mode)

Use the Device Editor (Editor Mode) to enter and display settings. Make sure that the 

firmware in your radio matches the QuickSet settings driver; the driver version number 

in the lower left corner of the Device Editor should be equal to the first three digits 

following “Z” in the radio Firmware Identification (FID) string. Use the ID or STA 

command to easily view the FID string.

Entering Settings
Step 1. Click + in the Settings Tree View to expand and select the settings 

you want to change.

Step 2. Click Tab to navigate through the settings, or click on a setting.

Step 3. Right-click your mouse in the setting dialog box and select Previous 

Value to restore the previous value for a setting.

Step 4. Right-click your mouse in the setting dialog box and select Default 

Value to restore the factory-default setting value.

If you enter a setting that is out of range or has an error, QuickSet will show the error at 

the bottom of the Settings Editor. Double-click the error listing to go to the setting and 

enter a valid input.

Sending Settings

Select Save, Send, or Print Device Settings from the File menu of the Device Editor 

once settings are entered into QuickSet. This will ensure that your settings are not lost.

Table 4.2 Device Editor Menus

Menus Description

<< >> Moves from one category to the next.

Merge Merges the open record with another record.

Compare Compares the open record with another record.

Search Searches for a particular setting.

Part Number Displays part number.
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Options—Part Number

Select Edit > Part Number to change the part number if it was entered incorrectly 

during an earlier step.

Text Files

Select Tools > Settings > Import or Tools > Settings > Export on the Device Editor 

(Editor Mode) menu bar to import or export settings to or from a text file. Use this 

feature to create a small file that can be easily stored or sent electronically.

Meter and Control
Human Machine Interface (HMI)

Select Tools > HMI > HMI to bring up the screen shown in Figure 4.8. The HMI tree 

view shows the functions that are available from the HMI. The Meter & Control 

window is an easily organized view of real-time data and information stored in the 

SEL-3031.

Figure 4.8 Status Screen

The Status screen provides a real-time view of the radio to which it is connected. A 

user can see the current status of the SEL-3031 and verify any alarm conditions.
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Select the Radio Status screen to view the radio statistics. Included is the RSSI value 

that displays the current strength of the receive signal. This will aid in properly aiming 

the antenna for maximum signal strength. The “Availability” displays the overall 

channel availability of the link. The “Zone Availability” gives the availability of each 

of the 10 zones. See Monitoring Radio Performance on page 5.1 for more information 

on optimizing the radio link.

Figure 4.9 Radio Strength and Channel Availability

The SER window displays the same information as the ASCII SER commands. The 

Control Window allows you to clear the SER, synchronize with IRIG, and set the time 

and date.

Global Settings

Under the Global group settings category, set the device and host identifiers settings. 

The SEL-3031 displays the Device and Host Identifier strings at the top of the serial 

port commands responses, identifying messages from individual devices. Enter as 

many as 30 characters, including capital letters A–Z, numbers 0–9, periods, and 

dashes. Table 4.3 shows the device and host identifier settings.

Table 4.3 Global Settings (Sheet 1 of 2)

Setting Prompt Setting Range Setting Name := Factory Default

Device Identifier 30 characters DID

Host Identifier 12 characters (no spaces) HID
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Date_F allows you to change the device date presentation format to either North 

American standard (Month/Day/Year), Engineering standard (Year/Month/Day), or 

European standard (Day/Month/Year).

5V_EN enables the +5 V on Pin 1 on every EIA-232 DB-9 serial port. When this 

setting is on, all three ports will have +5 Vdc on Pin 1. The entire load on the +5 V 

must not exceed 500 mA.

Radio Settings

NETARCH sets the primary operation mode of the radio. P2P is the default mode 

which sets the radio to point-to-point mode where there is one master and one remote. 

In this mode all three serial ports can be used. In P2MP (point-to-multipoint) mode 

there can be one master and multiple remote radios. P2MP mode only uses Port 1 and 

disables Ports 2 and 3.

Date Format MDY, YMD, DMY DATE_F := MDY

Port Power ON, OFF 5V_EN := OFF

Table 4.4 Radio Settings

Settings Prompt Settings Range 
Setting Name := 
Factory Default

Network Architecture P2P, P2MP NETARCH := P2P

Operation Mode MASTER, REMOTE MODE := REMOTE

Network Identification 1–10 NID := 1 

Skip Zones (SEL-30310) 1–16, NONE SKIP := NONE 

Skip Zones (SEL-30311 Brazil) 1–3, 9–16, NONE SKIP := NONE 

Transmit Power 20–30 dB TXPWR := 30 

Radio Synchronization OFF, Send, Receive SYNC := OFF

Encryption Passphrase 8–80 Characters KEY := NONE 

Radio Address 0–65534 DEVADDR := 1

Address List of Connected 

Radios

Comma Separated Sequence 

(ex. 1,2,3 or 1–3,14–16)

RADIOLST := 0

Session Use Time-Out 10–600 seconds SUTIMEO := 30

Table 4.3 Global Settings (Sheet 2 of 2)

Setting Prompt Setting Range Setting Name := Factory Default
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MODE sets the operating mode of the radio. The radio is set to REMOTE by default. 

In P2P mode one radio must be set as MASTER and the other must be set to REMOTE. 

In P2MP mode the master is located at the data collection point and all other radios in 

the system set to REMOTE. In P2MP mode the master transmits to all the remote 

radios, and only one remote can respond to the master.

NID sets the network address of the radio network. All radios in the same network 

must be set to the same NID with the same SKIP zones to properly link and 

communicate. If more than one radio network exists then each network must be set to a 

different NID.

SKIP determines which of the 16 frequency zones to skip in the SEL-3031 hopping 

sequence. The SEL-30310 will operate on any10 of the 16 zones. The default setting is 

NONE. The SEL-30310 must use a minimum of 10 zones, a setting of NONE will 

force the radio automatically SKIP zones 11–16. The SEL-30311 for Brazil will 

operate on any 10 of the 11 Zones 1–3 and 9–16. A setting of NONE will force the 

SEL-30311 to automatically SKIP zone 16. The SKIP setting can contain as many as 

six comma-delimited zones from Table 4.5 or Table 4.6. Each zone entered in this 

setting will set the SEL-3031 to skip that particular zone in the hopping table. This 

setting can help increase the availability of the radio and avoid areas of interference.

The SEL-3031 has radio statistics to help set the SKIP setting if the availability of the 

radio is less than desired. To determine which frequency zones to skip, issue a 

RADio C command and let the radios run for a period of time. You will get better 

availability results the longer you let the radio run linked. Issue the RADio command 

to view the availability of each frequency zone. In the radio report identify the 

frequency zones with the lowest availability and enter these zones via the SKIP setting. 

If the radio zone availability is within 1 to 2 percent of each other, no SKIP setting 

changes are needed. The SKIP setting is for avoiding noisy occupied zones not from 

multipath effects that are seen by all zones. If the availability is below what is desired, 

Table 4.5 SKIP Zone Frequencies (SEL-30310)

Zone 1 Zone 2 Zone 3 Zone 4 Zone 5 Zone 6 Zone 7 Zone 8

902.6–

903.8

904.1–

905.3

905.6–

906.8

907.1–

908.3

909.2–

910.4

910.7–

911.9

912.2–

913.4

913.7–

914.9

Zone 9 Zone 10 Zone 11 Zone 12 Zone 13 Zone 14 Zone 15 Zone 16

915.2–

916.4

916.7–

917.9

918.2–

919.4

919.7–

920.9

921.2–

923.0

923.3–

924.5

924.8–

926.0

926.3–

927.5

Table 4.6 SKIP Zone Frequencies (SEL-30311 Brazil)

Zone 1 Zone 2 Zone 3 Zone 9 Zone 10 Zone 11

902.6–903.8 904.1–905.3 905.6–906.8 915.2–916.4 916.7–917.9 918.2–919.4

Zone 12 Zone 13 Zone 14 Zone 15 Zone 16

919.7–920.9 921.2–923.0 923.3–924.5 924.8–926.0 926.3–927.5

Preliminary Copy—Subject to Change



SEL-3031 Instruction Manual Date Code 20181001

Settings and Commands

Settings

4.14

it may be because of obstacles in the way or improper antenna alignment. Issue another 

RADio C command and let the SEL-3031 run for another day then verify that the 

availability has increased. See Section 5: Performance Monitoring, Testing, 

and Troubleshooting for more information on how to use the SKIP setting.

TXPWR sets the transmitted power of the SEL-3031. The available range is 

20–30 dBm (1 W). The radio transmit power is set in 1 dBm increments. The radio is 

shipped with a factory-default setting of 30 dBm. This setting must be used to reduce 

the power output if the total effective isotropically radiated power (EIRP) exceeds 

36 dBm. See Transmitted Signal on page 2.3 for more information on how to calculate 

and configure the maximum power output.

In the United States and Canada, the FCC and IC regulate the amount of power a radio 

can radiate with EIRP. The EIRP limit of radiation is 36 dBm. This value includes the 

power of the transmitter, cable losses, and antenna gain. If you exceed the allowed 

36 dBm, you must lower the transmitted power of the radio by using the TXPWR 

setting, and then measure the actual power.

See Transmitted Signal on page 2.3 for more information on determining and properly 

setting the TXPWR setting.

SYNC is used when more than one radio network exists with collocated antennas. The 

SYNC setting allows you to connect two or more radios together, enabling the radios to 

synchronize their hop sequences through the use of SEL Hop-Sync technology. SEL 

Hop-Sync technology synchronizes the hop sequence giving a much higher radio 

availability and dependability by removing adjacent antenna interference. The 

synchronizing allows you to install multiple antennas on the same pole and greatly 

reduce adjacent noise interference.

For all the collocated radios the MODE setting needs to be set as MASTER. One of the 

MASTER radios you set the SYNC to SEND and all of the other MASTER radios you 

set the SYNC to RECEIVE. You do not need to set the SYNC for the radios on the 

other end of the link. You only need to set the SYNC setting for the collocated radios. 

See Collocated Antenna Systems on page 2.8 for more information on properly cabling 

and using SEL Hop-Sync technology. For SEL Hop-Sync technology to properly work, 

each radio at the collocated site must have the SYNC settings set correctly and a cable 

on Port 3 connecting all the collocated radios.

The KEY setting is only available if the product contains an SEL-3044 Encryption 

Card. The KEY setting is a passphrase that is used to generate an encryption key. The 

acceptable range is from 8 to 80 characters. All printable characters are accepted. If 

you have an encryption card, this value must be set to enable the secure wireless 

connection. If MODE equals P2MP then the DEVADDR and RADIOLST must be set 

with the KEY setting to allow a master to talk to multiple remotes. If MODE is set to 

P2P then only the KEY setting is needed. When the SEL-3031 is shipped with the 

encryption card, or added in the field, it is by default shipped in reset mode. The SEC 

LED on the front panel will flash green to show this state. The KEY setting must be set 

to activate the encryption card. The SEL-3031 radios will not transmit data until the 

SEL-3044 is set properly. The SEC LED will illuminate green when the KEY setting is 
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correctly set. The green SEC LED indicates data being set through the radio link is 

secured. Once the KEY setting is configured the setting can never be read back, 

viewed, or saved with QuickSet.

To encrypt a radio link, both radios must contain an SEL-3044 and the KEY settings 

must be set to the same value. See Appendix B: Firmware Upgrade Instructions for 

more information on the SEL-3044 Encryption Card. The DEVADDR and RADIOLST 

settings are only available if the product contains an SEL-3044 Encryption Card and 

the network architecture is point-to-multipoint (NETARCH = P2MP). The DEVADDR 

Radio Address must be a unique address from 0 to 65534. Every radio on the same 

network must be set to a different address. The RADIOLST is the address list of 

allowed connected radios. Each radio will only accept communications from radios 

that have the device address in the radio list. All remote radios shall have the address of 

the Master radio address DEVADDR. The master radio needs a list of all the remote 

addresses it is allowed to communicate with. You can only have one master in a P2MP 

network and as many as 20 remotes with the Encryption Card. Adding a second master 

will stop all communications.

The SUTIMEO (session use time-out) setting is only available when the SEL-3044 

Encryption Card is present, NETARCH = P2MP, and MODE = MASTER. The 

SUTIMEO setting is used to set the maximum time the master must wait before talking 

with each remote in the RADIOLST setting. This setting must be set to the maximum 

time it will take for a SCADA master to poll all of the remote devices. Once this time is 

exceeded the master radio will attempt to reconnect to the remote while discarding all 

incoming SCADA data. This out-of-band messaging will take around 100 ms per lost 

device but will repeat every time the SUTIMEO expires. This timer resets each time a 

master receives a successful packet from the remote. If you no longer plan to 

communicate with a remote you should remove the device from the DEVADDR. The 

SUTIMEO will also set the maximum time before the master radio will recognize a 

new remote device added to the network. If you add a radio to an existing network, it 

will take as long as the SUTIMEO time before the master recognizes and authenticates 

the new remote.

NOTE: Do not include any addresses of radios that are not 
actively being used in the network. This will slow down 
the network with out-of-band messaging.

Port Settings

The SEL-3031 settings allow you to configure the parameters for each of the three 

communications ports. The SEL-3031 comes standard with three EIA-232 ports. In 

P2P mode all three serial ports are active. In P2MP mode only Port 1 is active, Port 2 

and 3 are disabled. Port 1 can be ordered as an EIA-232, EIA-485, or serial fiber-optic 

port. Table 4.7 shows the port settings ranges and default settings for Port 1, Port 2, and 

Port 3.
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The protocol setting defines the type of data that will be passing through the serial port. 

This setting automatically sets parameters in the radio to optimize best performance. In 

P2P mode, any of the three serial ports may be set to any of the protocols. Ports 2 and 3 

are always EIA-232 ports. For example, you have three ports of MIRRORED BITS® 

(MB8), or any combination or MB8, MODBUS, and STANDARD.

PROTO sets the intended protocol used to communicate through the radio ports. Set to 

STANDARD for all byte-oriented protocols such as DNP3, ASCII, Synchrophasors, or 

file transfer. This is the default setting for PROTO and should be used unless you are 

using MIRRORED BITS or MODBUS. Set PROTO to MB8 to work with SEL 

MIRRORED BITS devices (P2P mode only). The SEL-3031 only supports MB8 

MIRRORED BITS protocol in P2P mode. MIRRORED BITS MB8 is not supported when 

operating in point-to-multipoint (P2MP) mode. See Section 3: Job Done Examples for 

more information on setting up MIRRORED BITS. Set PROTO to MODBUS when used 

with Modbus protocol. MODBUS has strict character spacing rules that warrant the 

specific setting to properly transport the protocol. When using MODBUS in P2P or 

P2MP the PROTO settings must be set to MODBUS and the connected devices must 

be set to 8 data bits, no parity, and 1 stop bit.

ARQ (Automatic Repeat Request) sets the radio to repeat any radio packets that fail 

the data packet error checking or do not arrive at the other radio. ARQ is available 

when the PROTO setting is set to Standard or MODBUS. ARQ is disabled when 

PROTO is set to MB8. ARQ by default is set to Y. This setting should always be set to 

Y unless you use a protocol where time-sensitive data are necessary in an application 

where dropping delayed packets is preferred. In P2P mode, ARQ will repeat failed data 

packets traveling in both directions. In P2MP mode, only data transferring from the 

remote to the master will repeat upon error.

Table 4.7 Port Settings 

Settings Prompt  Settings Range 
Setting Name := Factory 
Default 

 Protocol  STANDARD, MB8, MODBUS  PROTO := STANDARD 

ARQ Automatic Repeat Request ARQ:=Y

SPEED 9600, 19200, 38400 (9600, 

19200 with Encryption Card)

SPEED=19200 (9600 with 

Encryption Card)

 CTS State  Asserted, Deasserted  CTS := DEASSERTED 

 Echo  ON, OFF  ECHO := OFF 
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Ports 2 and 3 are fixed at 9600 bps with the SEL-3044 Encryption Card. The default 

setting for SPEED is 19200, or 9600 bps with the Encryption Card. If the radio is in 

P2P mode and the Port 1 SPEED is set to 38400 then Port 2 will be disabled. In P2MP 

mode only Port 1 is enabled and a setting of 9600, 19200, or 38400 bps (9600 or 19200 

with the SEL-3044 Encryption Card) is allowed.

The CTS setting is used to set the state of the CTS (Pin 7) line on each of the ports. In 

most cases this setting should be set to deasserted. Most SEL devices require CTS 

deasserted for them to respond to DNP requests. The SEL-3031 does not support 

hardware flow control. It will only assert or deassert the CTS line to signal connected 

equipment to continue communication. If radio synchronization is enabled, SYNC  

OFF, then Port 3 CTS setting is disabled.

The ECHO setting is only enabled when Port 1 is ordered as an EIA-485 device. This 

setting is used to set up a two-wire versus four-wire EIA-485 connection. The default 

ECHO setting is set to ON, which works with four-wire EIA-485 applications. For 

two-wire operation, the ECHO setting must be set to OFF, and Pins 1 and 7 and Pins 2 

and 8 must be connected together (see Table 2.11).

Commands

Access Levels

Issue commands to an SEL-3031 serial port to view or change device settings or 

retrieve information. For security, these commands are available on different password-

protected access levels. Throughout this section each command description indicates 

the access level at which the command is available. There are four access levels in the 

device, offering varying levels of control.

➤ Access Level 0 commands are the lowest security level. Access 

Level 0 commands support minimum identification.

➤ Access Level 1 commands are for reviewing information only 

(e.g., status) and not for making any changes.

Table 4.8 Fixed Port Settings

Port Setting Fixed Port Settings
Fixed Port Settings With 
SEL-3044 Card

Data Rate (Port 2 and 3) settable 9600 bps

Data Bits 8 8

Parity None None

Stop Bit 1 1

RTS/CTS Flow Control Off Off
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➤ Access Level 2 commands are for changing device settings.

➤ Access Level C (restricted access level—should be used under 

direction of SEL only).

Go to Communications on page 4.2 for instructions on connecting to the SEL-3031 

through the USB interface.

The virtual serial interface created from the USB port must be set to 9600 bps, 8 data 

bits, 1 stop bit, and no parity to communicate to the SEL-3031.

Access Level 0

Once serial port communication is established with the SEL-3031, press <Enter> and 

you should see the following prompt:

=

NOTE: If you don't get the = prompt, then refer back to 
Communications on page 4.2 to properly connect to the 
SEL-3031.

This is referred to as Access Level 0. Only a few commands are available at this level. 

One is the ACC command.

Enter ACC at the Access Level 0 prompt:

=ACC <Enter>

The ACC command takes the SEL-3031 to Access Level 1.

Access Level 1

When the SEL-3031 is in Access Level 1, the device sends the following prompt:

=>

From Access Level 1, use the 2AC command to go to Access Level 2. 

Enter 2AC at the Access Level 1 prompt:

=>2AC <Enter>
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Access Level 2

When the device is in Access Level 2, the SEL-3031 sends the following prompt:

=>>

All of the Access Level 1 commands are available in Access Level 2. The SEL-3031 

responds with Invalid Access Level when a command is entered from an access 

level lower than the required level for the command. The device responds with 

Invalid Command to commands that are not available or are entered incorrectly.

Access Level C

The CAL access level is used exclusively by the SEL factory and SEL field service 

personnel to diagnose troublesome installations. A list of commands available at the 

CAL level is available from SEL upon request. Do not enter the CAL access level 

except as directed by SEL.

The CAL command allows the device to go to Access Level C . Enter the CAL 

command at the Access Level 2 prompt:

=>>CAL <Enter>

ASCII Commands

The SEL-3031 includes ASCII commands and settings to properly set the SEL-3031. 

QuickSet provides a user-friendly interface to set the SEL-3031, but either interface 

can be used to set the product.

DATE Command

Use the DATE command to view and set the date, as shown in Table 4.9.

The device can overwrite the date entered with other time sources, such as IRIG. Enter 

DATE to set the internal clock date. Separate the month, day, and year parameters with 

slashes. Set the year in four-digit format (for dates 2000–2099).

Table 4.9 DATE Command

Command Description Access Level

DAT Displays the internal clock date. 1

DAT date Sets the internal clock date (DATE_F set to MDY, 

YMD, or DMY).

1

Preliminary Copy—Subject to Change



SEL-3031 Instruction Manual Date Code 20181001

Settings and Commands

Commands

4.20

IDENTIFICATION Command

The ID command extracts device identification codes, as shown in Table 4.10. The ID 

command is only available as a compressed (comma-delimited) command.

IRIG Command

Use the IRI command to read the demodulated IRIG-B time code at the management 

port or IRIG-B input, and to force immediate synchronization of the internal clock with 

the IRIG-B signal (see Table 4.11). If an IRIG-B signal is present at serial Port 2, the 

device will automatically synchronize the internal clock with the IRIG-B signal in a 

time period not exceeding one minute. It is not necessary to issue the IRI command for 

this automatic synchronization. If you are testing the device and do not want to wait for 

the one-minute synchronization, issue the IRI command to force the device to 

synchronize immediately with the IRIG-B signal. You can also use the IRI command 

to determine whether the device is properly reading the IRIG-B signal.

t

To force the device to synchronize to IRIG-B, enter the following command:

=>IRI <Enter>

If the device successfully synchronizes to IRIG-B, it will send the following header 

and access level prompt:

SEL-3031                     Date: 04/12/2005   Time: 15:41:29

DEVICE

=>

Table 4.10 ID Command

Command Description Access Level

ID Returns a list of device identification codes, as shown 

below:
=ID <Enter>

"FID=SEL-3031-R100-V0-Z001001-D20091009","08D2"

"BFID=SLBT-3031-X307-V0-Z000000-D20091009","0974"

"CID=2B957901","0330"

"DEVID=RADIO 1","03D9"

"DEVCODE=72","0310"

"PARTNO=30310W01XXX","0538"

"CONFIG=00000000","03E3"

"SPECIAL=0","02DE"

1

Table 4.11 IRIG Command

Command Description Access Level

IRI Forces synchronization of internal control clock to 

IRIG-B time-code input.

1
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If no IRIG-B code is present at the serial port input, or if the code cannot be read 

successfully, the device will respond as follows:

IRIG-B DATA ERROR

=>

L_D Command

Use L_D to load firmware, as shown in Table 4.12. See Appendix A: Firmware and 

Manual Versions for information on firmware and instruction manual changes.

PASSWORD Command

Use PAS to view or change existing passwords, as shown in Table 4.13 and Table 4.14.

WARNING
This device is shipped with default passwords. Default passwords should be changed to private 
passwords at installation. Failure to change each default password to a private password may allow 
unauthorized access. SEL shall not be responsible for any damage resulting from unauthorized 
access.

To change the password for Access Level 2 from the default password TAIL to new 

password Ot3579, enter the following:

=>>PAS 2 <Enter>

Old PW:? **** <Enter> (Enter TAIL)

New PW:? ******* <Enter> (Enter Ot3579)

Confirm PW:? ******* <Enter> (Enter Ot3579)

Table 4.12 L_D Command

Command Description Access Level

L_D Downloads firmware to the device. 2

Table 4.13 PAS Command

Command Description Access Level

PAS level new passwords Sets a password for new password for 

Access Level level.a

a Parameter level represents the device Access Levels 1 or 2.

2

Table 4.14 Factory-Default Passwords

Access Level Password

1 OTTER

2 TAIL

CAL CLARKE
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Password Changed

CAUTION: This password can be strengthened. Strong passwords do not include a name, date, 

acronym, or word. They consist of the maximum allowable characters, with at least one special 

character, number, lower-case letter, and upper-case letter. A change in password is 

recommended.

=>>

Similarly, use PAS 1 to change Access Level 1 passwords. Passwords can contain as 

many as 12 characters. Uppercase and lowercase letters are considered different 

characters. Strong passwords have 12 characters with at least one special character or 

digit and mixed-case sensitivity, and do not form a name, date, acronym, or word. 

Passwords formed in this manner are less susceptible to password guessing and 

automated attacks. Examples of valid, distinct, strong passwords are shown below.

➤ #Ot3579!ljd7

➤ $A24.68&,mvj

➤ (Ih2dcs)36dn

➤ *4u-Iwg+?lf-

If you forget your password, you can reissue a new password by following these steps:

Step 1. In accordance with the appropriate safety regulations, turn off the 
device, and see Front-Panel Jumpers on page 2.14 for instructions on 
accessing the jumpers.

Step 2. Go to Table 2.7 to locate Jumper 2 and short the jumper as shown.

Step 3. Go to the appropriate access level and issue PAS x (x = 1 or 2) to 
enter a new password.

Step 4. In accordance with the appropriate safety regulations, turn off the 
device and remove Jumper 2 to activate the password function.

Step 5. Replace the front-panel cover and turn on the device.

Table 4.15 Valid Password Characters

Alpha
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

a b c d e f g h i j k l m n o p q r s t u v w x y z

Numeric 0 1 2 3 4 5 6 7 8 9

Special ! “ # $ % & ‘ ( ) * + , - . / : ; , = . ? @ [ \ ] ^ _ ‘ { | } ~
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QUIT Command

Use QUIT to revert to Access Level 0 from either Access Level 1 or Access Level 2, 

as shown in Table 4.16.

Access Level 0 is the lowest access level; your SEL-3031 does not require a password 

check to descend to this level (or to remain at this level).

RADIO Command

The RAD command is for viewing statistics and data on the radio link, as shown in 

Table 4.17. The RAD command provides two important types of information.

➤ RSSI = Receive Signal Strength Indicator. The RSSI shows the 

current strength of the receive signal from the radio. This command 

helps you to refine antenna positioning. The RSSI is reported in dBm 

and updates every time the RAD command is issued. The RSSI is 

calculated from the latest 50 frequency hops averaged over time. 

RSSI is very useful for optimizing performance on directional 

antennas and monitoring signal strength.

➤ Availability. The radio automatically calculates the availability of the 

overall radio link and the availability of each hopping frequency. The 

availability is calculated by measuring the number of good radio 

frames received per the number of radio frames expected. The 

Overall is the tallied availability of each of the frequency zones used 

in the current hopping table. This number is valuable for measuring 

overall radio availability. The SEL-3031 also calculates the 

availability of each zone used in the current hopping table. The radio 

zones displayed in the RAD command are based on the SKIP setting. 

See Table 4.5 for more information on Skip Zones. See Section 5: 

Performance Monitoring, Testing, and Troubleshooting for more 

information on using the availability to set the SKIP setting for 

improved radio performance. The master radio in P2MP mode will 

only calculate availability on received packets.

Table 4.16 QUIT Command

Command Description Access Level

QUI Sends you to Access Level 0. 0

Table 4.17 RAD Command

Command Description Access Level

RAD View radio statistics 1

RAD C Clear radio statistics 2
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1         2         3         4         5         6         7         8

12345678901234567890123456789012345678901234567890123456789012345678901234567890

[Common Header]

RSSI

 -69 dBm

AVAILABILITY:        From 10/02/2009 17:33:21

Overall

100.00 %

Zone  1     Zone  2     Zone  3     Zone  4     Zone  5

100.00 %    100.00 %    100.00 %    100.00 %    100.00 %

Zone  6     Zone  7     Zone  8     Zone  9     Zone 10

100.00 %    100.00 %    100.00 %    100.00 %    100.00 %

Figure 4.10 RAD Command Response

SER Command

Use SER to view and manage the Sequential Events Recorder report, as shown in 

Table 4.18.

If the requested SER report rows do not exist, the device will respond with the 

following:

NO SER data

SET Command

The SET command is for viewing or changing device settings, as shown in Table 4.19. 

Append TERSE to skip the settings display after the last setting. Use this parameter to 

speed up the SET command. If you want to review the settings before saving, do not 

use the TERSE option.

Table 4.18 SER Command

Command Description Access Level

SER Displays a chronological progression of all avail-

able SER rows (as many as 1024 rows); Row 1 is 

the most recent and Row 1024 is the oldest.

1

SER row 1

SER row 1 row 2

SER date 1

SER date 1 date 2

Displays a chronological or reverse chronological 

subset of the SER rows.

1

SER C Clears/resets all SER records. 2
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Append the specific setting name you want to change in the SET command to 

immediately jump to the setting. If s is not entered, the device starts at the first setting. 

For example, to directly jump to the TXPWR setting in the Radio setting category, 

enter SET R TXPWR <Enter>. This will take you directly to the TXPWR setting. 

If you want to set all of the Radio settings, issue the SET R command and it will start 

at the beginning of the settings list. Enter the desired setting value or press <Enter> to 

accept the existing setting, as shown in Table 4.20.

The device checks each setting to ensure that it is within the allowed range. If the 

setting is not within the allowed range, the device generates an Out of Range 

message and prompts you for the setting again. When all the settings are entered, the 

device displays the new settings and prompts you for approval to enable them. Answer 

Y <Enter> to enable the new settings. The device is disabled for no longer than one 

second while saving the new settings. The ALARM LED illuminates momentarily and the 

ENABLED LED extinguishes while the device is disabled.

SHOW Command
When showing settings, the radio displays the settings label and the present value from 

nonvolatile memory for each setting class as shown in Table 4.21.

Table 4.19 SET Command (Change Settings)

Command Description Access Level

SET G sa

a s = specific setting name.

Set Global settings 2

SET R s Set Radio settings 2

SET P s Set serial Port settings 2

Table 4.20 SET Command Editing Keystrokes

Press Key Results

<Enter> Retains the setting and moves to the next setting.

^<Enter> Returns to the previous setting.

< <Enter> Returns to the previous setting category.

> <Enter> Moves to the next setting category.

END <Enter> Exits the editing session, then prompts you to save the settings.

<Ctrl+X> Aborts the editing session without saving changes.
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Append s and the specific settings name you want to view in the SHOW command to 

immediately jump to the setting. If s (and the settings name) is not included, the device 

presents settings beginning with the first in the group.

STATUS Command
Use STA to display the status report, as shown in Table 4.22.

Refer to Section 5: Performance Monitoring, Testing, and Troubleshooting for self-test 

thresholds and corrective actions, as well as information on hardware configuration 

conflict resolution. Figure 4.11 shows the device response to the STA command.

=>STA <Enter>

RADIO 1                                 Date: 9/16/2010   Time: 04:29:13

STATION_A                               Time Source: Internal

Serial Number: 000000000000000

FID=SEL-3031-R101-V0-Z002001-D20100723  CID=8BCE91D9

RFID=SEL-3031-R101-V0-D20101630

BFID=SLBT-3031-R100-V0-Z000000-D20091009

Part number 30310W01XXX

Radio Link

LINK         RSSI         AVAILABILITY

YES          -29 dBm       99.63 %

Radio Configuration

NETWORK      MODE         NID       SYNC

P2P          MASTER        5        OFF

PORT 1       PORT 2       PORT 3

STANDARD     STANDARD     STANDARD

19200        19200        19200

SELF TEST RESULTS

FLASH OK     SDRAM        RTC       SEC

OK           OK           OK        ABSENT

Table 4.21 SHO Command (Show/View Settings)

Command Description Access Level

SHO G s Show Global settings 1

SHO R s Show Radio settings 1

SHO P s Show serial Port settings 1

Table 4.22 STA Command (Device Self-Test Status)

Command Description Access Level

STA n Displays the device self-test information n times 

(n = 1–32767). Defaults to 1 if n is not specified.

1

STA C Reboots the device and clears self-test warning and 

failure status results.

2

Preliminary Copy—Subject to Change



Date Code 20181001 SEL-3031 Instruction Manual

Settings and Commands

Commands

4.27

Device Enabled

=>

Figure 4.11 Device Response to the STATUS Command

Table 4.23 shows the status report definitions and message formats for each test.

TIME Command

Use TIME to return information about the SEL-3031 internal clock, as shown in 

Table 4.24. You can specify hours and minutes (seconds data are optional). Separate 

the hours, minutes, and seconds with colons, semicolons, spaces, commas, or slashes.

Enter TIME hh:mm and TIME hh:mm:ss to set the internal clock time. The value hh 

is for hours 0–23; the value mm is for minutes 0–59; the value ss is for seconds 0–59. If 

you enter a valid time, the device will update, save the time in nonvolatile memory, and 

display the time entered. If you enter an invalid time, the SEL-3031 will respond with 

Invalid Time.

Table 4.23 STA Command Report 

Status Report 
Designator

Definition Message Format

FID Firmware identifier string Text Data

RFID FPGA Firmware identifier string Text Data

BFID SELBOOT Firmware identifier string Text Data

Part Number Part Number of the SEL-3031 Text Data

PORT 1, 2, 3 Protocol setting for Port 1, 2, and 3 STANDARD, MB8, MODBUS

FLASH Nonvolatile memory integrity OK/FAIL

SDRAM Integrity of code that runs in RAM OK/FAIL

RADIO Radio module status OK/FAIL

RTC Real-Time Clock status OK/FAIL

SEC SEL-3044 Encryption Card status OK/ABSENT/RESET/FAIL

Table 4.24 TIME Command Definitions

Command Description Access Level

TIME Displays the present internal clock time. 1

TIME hh:mm Sets the internal clock to hh:mm. 1

TIME hh:mm:ss Sets the internal clock to hh:mm:ss. 1
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Section 5
Performance Monitoring, Testing, 

and Troubleshooting

Overview

This section provides information on monitoring radio performance, testing, and 

troubleshooting. Because the SEL-3031 is equipped with extensive self-tests, 

traditional periodic test procedures may be eliminated or greatly reduced.

Monitoring Radio Performance

This section describes the tools you can use to monitor and improve the radio 

performance. This section assumes that the radio link is up and running in service. 

There are several items that you can use to optimize the radio link. The first section 

explains how to optimize standard radio links using DNP3, Modbus®, or other byte-

oriented protocols. The second section addresses monitoring the radio performance 

when using MIRRORED BITS®.

Monitoring and Improving Radio Link Performance

This section assumes the radio link is up and running with sufficient link availability. If 

the radio link is either not working or has very low availability view Section 2: 

Installation for information on properly installed and operating the radio.

Obtain access through the front USB port either with a terminal program or 

ACSELERATOR QuickSet® SEL-5030 Software. Access Level 1 and issue the RAD 

command (see Figure 5.1). The first value from the report is the RSSI receive signal 

strength indication. This is the level of received level strength of the radio given in 

dBm. A good radio link should have 15 dBm of margin to account for environmental 

conditions and signal fade. The SEL-3031 receiver is rated down to –97 dBm or 

–104 dBm with ARQ on. If you observe a fade margin of 15 dBm or greater then you 

are receiving a strong signal. If the fade margin is less than 15 dBm that does not mean 

the radio link will not work; it means that the performance and channel availability 

needs to be monitored. To increase the signal or availability numbers the radio antenna 

may need to be adjusted, output power increased, antenna replaced with a with a higher 

gain antenna, (not to exceed transmit power of 36 dBm EIRP), or the SKIP setting used 

to avoid zones with low availability. A path study should always be done before the 
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radio is installed. The RSSI value should match to the results of the path study. If the 

path study numbers do not match the actual results then either the data entered is 

incorrect or information about the locations was omitted. Contact SEL if you cannot 

get the calculated values to match the measured values.

RADIO 1                                  Date: 09/11/2009   Time: 10:54:26

STATION_A                                Time Source: Internal

RSSI

 -46 dBm

AVAILABILITY:        From 09/11/2009 10:53:50

Overall

100.00 %

Zone  1     Zone  2     Zone  3     Zone  4     Zone  5

100.00 %    100.00 %    100.00 %    100.00 %    100.00 %

Zone  6     Zone  7     Zone  8     Zone  9     Zone 10

100.00 %    100.00 %    100.00 %    100.00 %    100.00 %

Figure 5.1 Example RAD Command

If you are using directional antennas, verify they have identical orientation—both sides 

must be either polarized horizontally or vertically. Typically, a vertically polarized 

antenna will give better results than a horizontally polarized antenna. If the location of 

the radio antenna is shared with other antennas operating at the same frequency, then 

proper spacing and opposite polarization should be used on one set of the antennas, 

along with using the SKIP setting. If two or more SEL-3031 radios are collocated 

using SEL Hop-Sync, see Configuring Collocated Antennas Using SEL Hop-Sync 

Technology on page 3.16. See Section 2: Installation for more information on antenna 

installation. Check the aiming of the antenna while updating the RAD command until 

you get the strongest signal. This will require two people, where one person is moving 

the position of the antenna in small increments, while the other is monitoring the RSSI. 

The antenna position must be rotated on both sides to obtain the highest signal 

strength. The RSSI must also be reviewed on each radio. The receive strength on the 

remote radio will likely be different than the received strength on the master radio.

The last step to check is the availability of the radio link. The RAD command gives the 

overall availability of the link. For protection systems the desire is to have a radio link 

between 95 and 99.95 percent availability. This overall availability number is a great 

way of directly obtaining this number. If you are running MIRRORED BITS then use the 

availability number in the communications report in the MIRRORED BITS device.

NOTE: The radio and the MIRRORED BITS report measure 
availability differently. Use the radio availability numbers 
for proper radio installation. Use the MIRRORED BITS 
communications report numbers when measuring the 
overall availability of your protection or control 
communications channel.
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To get a good availability reading, issue a RAD C command from Access Level 2. This 

will reset all of the availability numbers. Let the radio link run for a couple of days or 

longer. The longer period of time, the more accurate the numbers. After a few days 

have passed issue the RAD command and view the availability numbers. If the overall 

availability number is less than desired then look at the availability numbers per zone. 

If all of the zones are down in availability then more adjustment is needed on the 

antennas. If a few of the zones are down by a large percentage and the rest are 

acceptable then go back to the radio settings and change the SKIP zone setting. Enter 

the zones, as many as six, that you want to skip with the lowest availability. Issue a 

RAD C command and let the radio run for a couple of days.

NOTE: If the radio availability is above 85%, there is, at 
best, a marginal gain for skipping that zone.

You may need to repeat these steps before the availability reaches the desired level. 

Note: There are 16 zones available in the SEL-3031 where a radio link only uses a 

maximum of 10 zones. Skipping zones will turn on zones not previously used and may 

give worse performance. The default SKIP setting of NONE will make the SEL-30310 

SKIP zones 11–16, or force the Brazilian SEL-30311 to skip zone 16. If the availability 

between the zones only varies by a few percent then changing the SKIP setting will not 

help. The SKIP setting is for avoiding areas with high levels of noise, not to overcome 

multipath propagations.

If the overall availability of most of the zones is bad (below 85%) and positioning the 

antenna did not help then the radio link has a large amount of interference or there is an 

obstruction to the Fresnel zone that is causing reflection issues. The interference can be 

caused by a number of items. A path study is critical to determine how good the line-

of-sight is and how high the antennas need to be. If the path study results do not match 

your actual results you will need to make sure all of the parameters used to make the 

path study were correct. If the results still do not match then there is an unaccounted 

obstruction in the path (either buildings or trees) that is causing the decrease in 

availability. View Section 2: Installation for more information on properly installing 

the antenna. If the availability numbers are less than desired then the problem is within 

the location, interference, or multipath radio issues. If the antenna tower is not located 

high enough and proper steps are not done to detect noise floors or obstructions to the 

Fresnel zone then the availability numbers may not reach those used in the path study.

Monitoring MIRRORED BITS Performance

When using one, two, or three ports of the SEL-3031 for MIRRORED BITS 

communications it is important to monitor the availability of the channel. The 

SEL-3031 provides channel availability information and the MIRRORED BITS devices 

each contain communications data for each MIRRORED BITS channel. This section 

describes how these work and how to optimize the MIRRORED BITS channel to achieve 

a high level of availability.
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The end of the previous section describes how to measure the availability of the radio 

link. All SEL relays that have MIRRORED BITS give a full channel monitoring report 

that will give the unavailability and a report on all of the data drops. The SEL-3031 

displays the availability and SEL MIRRORED BITS devices display the unavailability. 

The relationship of the two is represented below.

Availability = 1 – Unavailability

The SEL-3031 will show a lower availability than shown by the SEL relays with 

MIRRORED BITS. The difference lies in how the radio monitors each packet of 

MIRRORED BITS. Upon detecting bad packets the SEL-3031 removes the packets 

before they reach the relay. The relay will only declare a dropped channel if it receives 

bad data or after a period of time expires without seeing a new data packet. This gives 

the SEL-3031 a chance to ride through several bad hops, remove corrupted data, keep 

the channel up and operating, and minimize the amount of total unavailability as seen 

by the MIRRORED BITS devices.

Before you use an SEL device’s MIRRORED BITS communications report, make sure 

you go through Monitoring and Improving Radio Link Performance to verify the radio 

is optimized and the SKIP setting is set to avoid noisy zones. 

Monitoring MIRRORED BITS performance over a radio link is critical to ensure proper 

operation when called upon to operate. The RBAD and CBAD bits provided in every 

SEL device with MIRRORED BITS can be used to alarm when the radio link is degraded 

below levels needed for proper operation. 

➤ RBADPU: Setting for the amount of time the channel is in a failed 

state before setting the RBAD alarm Relay Word bit.

➤ CBADPU: Setting for the threshold of the CBAD channel availability 

alarm.

When a MIRRORED BITS channel is operating correctly, Relay Word bit ROK is set to 1. 

When the channel is disturbed, ROK drops out. The ROK bit is not recommended for 

use as an alarm point. ROK is a good indication of the channel’s health. If the ROK bit 

is toggling, this is an indication of an intermittent channel problem.

Figure 5.2 RBAD Generation

MIRRORED BITS 

Decoder and Integrity

Checks

ROK

RBAD 

Timer RBAD

Serial Data
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The RBAD bit is generated by the output of the RBAD timer. The RBAD timer is 

driven by the ROK signal. RBAD is the recommended bit to indicate communications 

alarms. Typically, a communications outage of two seconds or greater is considered an 

alarm condition. RBAD should be set on both MIRRORED BITS device to the maximum 

length of outage before declaring an alarm.

The CBADPU setting is generated from the unavailability of the MIRRORED BITS 

channel. For example, if RBADPU is set to 2 seconds and the longest channel 

disruption was 1 second out of every second and this occurred every 2 seconds, RBAD 

would not assert. RBAD would not assert because MIRRORED BITS is not disrupted for 

longer than 2 seconds at any time. Relay Word bit CBAD and the CBADPU setting 

solves this problem. To set CBADPU there are two good options. The first option is to 

set it to 2000. This is a common value used based upon spread spectrum radio use in 

the field. The CBAD Relay Word bit will assert when the unavailability of the channel 

exceeds 0.02.

The other method in setting CBAD is to let the radio link run for a period of time and 

monitor the performance. After reviewing a month of unavailability you will be able to 

set CBADPU above the unavailability value.

The proper setting and use of CBAD and RBAD is important to report when the 

communications link has failed or has become intermittent enough to cripple proper 

communication. Over time, many issues can occur to cause a bad or intermittent radio 

link. Items such as tree growth, new building construction, or another radio added at 

the site or in the path of the current radio link. It is important to take CBAD and RBAD 

and use them in the relay to trigger an alarm condition through an output contact or 

have the SCADA system detect the alarm. Line-of-site radio paths can experience 

adverse conditions over time and it is critical to constantly monitor the radio 

performance to keep the availability numbers as high as possible.

Self-Test

All self-tests are described in Table 5.1. If all diagnostic tests are passed, the ENABLED 

LED is on, the ALARM LED is off, and the contact output is open. If the device is 

disabled, the ENABLED LED is off, the ALARM LED is illuminated, and the contact output 

is closed.

Table 5.1 Device Self-Tests (Sheet 1 of 2)

Self-Test Description
SER 
Message

Alarm 
LED

Alarm 
Contact

FPGA Version 

Mismatch

Fails if FPGA registers do not match 

expected.

Yes On Closed

Data RAM Performs read/write tests on each 

section of Data RAM.

Yes On Closed
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Troubleshooting

Code RAM Performs a comparison test against 

code flash.

Yes On Closed

Code Flash Checksum is continually computed 

on code base.

No On Closed

Flash (Settings) Performs a validity test every hour 

on the settings.

Yes On Closed

Processor 

Exception

Indicates processor failure. Yes On Closed

RTC Indicates clock chip static RAM fail-

ures.

Yes On Closed

Table 5.2 Troubleshooting Tips (Sheet 1 of 2)

Symptom Probable Cause Corrective Action

ALARM LED is ON Radio recognized a status 

failure.

Turn unit off, and then on, and 

issue the STATUS command. 

If alarm signal returns, return 

unit to the factory for repair.

ALARM LED flashes ON 

every half second.

Radio detected a VSWR 

error where there is an 

open or short on the 

antenna port.

Verify all connections from the 

antenna to the radio are secure. 

Verify the antenna, feedlines, 

or lightning arrestor is not 

damaged.

The SEC LED is flashing. The SEL-3031 properly 

detects the encryption 

card but the card is in 

reset and doesn't have the 

key set.

Use QuickSet and set the KEY 

setting. This must be set the 

same on both radios.

Cannot connect to the 

radio through the USB 

port.

USB driver not installed 

properly.

Check for active SEL to USB 

drivers from your PC in Device 

Manager Ports section. If that 

does not work, uninstall and 

reinstall the driver and restart 

your PC. Make sure the 

SEL-3031 is powered on 

before plugging in the USB 

cable.

Table 5.1 Device Self-Tests (Sheet 2 of 2)

Self-Test Description
SER 
Message

Alarm 
LED

Alarm 
Contact
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Cannot change radio set-

tings.

Invalid password. Install password disable jumper 

and change passwords using 

the PAS command. See Pass-

word Jumper on page 2.14 for 

information on how to disable 

passwords.

Wall-mount radio will not 

turn on.

The polarity of the power 

supply wires is reversed.

Check the correct polarity and 

reverse if incorrect.

The remote radio will not 

link up to the master.

Radio address or mode is 

not set correctly.

The master and remote radios 

must be set to the same address 

and have the same SKIP set-

tings. Check that the master 

radio LINK light is ON and that 

the NID address and SKIP set-

ting is set correctly on both 

units.

Antennas are not pointed 

correctly, or there is a bad 

antenna cable.

Use QuickSet on the radio to 

issue the RAD command to 

check for signal strength. If the 

signal is low, try to re-aim both 

antennas to gain signal strength 

and check for bad antenna 

cables. See Section 2: Installa-

tion for more information on 

proper radio installation.

Table 5.2 Troubleshooting Tips (Sheet 2 of 2)

Symptom Probable Cause Corrective Action

Preliminary Copy—Subject to Change



This page intentionally left blank

Preliminary Copy—Subject to Change



Date Code 20181001 SEL-3031 Instruction Manual

Appendix A
U.Instruction Manual

Firmware and Manual Versions

Firmware

Determining the Firmware Version in Your Device

To determine the firmware version, view the status report by using the serial port 

STATUS command. The status report displays the Firmware Identification (FID) 

number.

The firmware version number is after the R, and the release date is after the D. For 

example, the following string shows firmware version number 100 with a release date 

of October 9, 2009:

FID=SEL-3031-R100-V0-Z001001-D20091009

Table A.1 lists the firmware versions, revision descriptions, and corresponding 

instruction manual date codes.

Table A.1 Firmware Revision History (Sheet 1 of 2)

Firmware Identification 
(FID) Number

Summary of Revisions
Manual 

Date Code

SEL-3031 Firmware Version:

SEL-3031-R104-V0-Z003001-

D20111228

FPGA Version:

SEL-3031-R101-D20101018

SEL-3044 Firmware Version:

SEL-3044-R102-V0-Z001001-

D20111223

Note: The SEL-3044 

Encryption Card can only be 

upgraded by sending the card 

back to the factory. Please 

contact the factory for assis-

tance.

➤ Fixed an issue in the SEL-3044 where 

the random number generator seed 

issued matching back-to-back samples 

that caused the card to stop passing data.

➤ Fixed an issue in the SEL-3044 where 

time-out behavior is treated as a hard 

failure causing the card to stop communi-

cating.

➤ Corrected a key-handling issue in the 

SEL-3044 forcing the master to set the 

sequence key to 0 every time the slave 

requests a new key.

20111228

Preliminary Copy—Subject to Change



SEL-3031 Instruction Manual Date Code 20181001

Firmware and Manual Versions

Instruction Manual
A.2

Instruction Manual

The date code at the bottom of each page of this manual reflects the creation or revision 

date.

Table A.2 lists the instruction manual versions and revision descriptions. The most 

recent instruction manual version is listed first.

➤ Fixed an issue in the SEL-3044 where 

the rollover of the encryption key could 

get repeated indefinitely and cause com-

munications to stop.

➤ Fixed an issue in the SEL-3044 where 

the master could receive a repeated mes-

sage from the radio that should have 

been dropped, causing the SEL-3044 to 

stop processing incoming data.

Firmware Version:

SEL-3031-R103-V0-Z003001-

D20110818

FPGA Version:

SEL-3031-R101-D20101018

Note: You must update both 

firmware and FPGA for 

proper operation.

➤ Fixed issue that prevented the encryp-

tion card from rekeying under certain 

conditions, which also stopped commu-

nication.

➤ Created Brazil frequency compatible 

version.

➤ Added 9600 bps speed setting option to 

all ports in radios without encryption 

cards.

20110818

Firmware Version:

SEL-3031-R102

➤ This firmware version was not produc-

tion released.

—

Firmware Version:

SEL-3031-R101-V0-Z002001-

D20101108

FPGA Version:

SEL-3031-R101-D20101018

Note: You must update both 

firmware and FPGA for 

proper operation.

➤ Added P2MP capability.

➤ Added the capability to synchronize col-

located radios.

➤ Added ARQ for non-MIRRORED BITS 

applications.

➤ Improved the STA command with more 

radio information.

➤ Added 38400 bps option on Port 1 

(19200 bps with Encryption Card).

20101108

SEL-3031-R100-V0-Z001001-

D20091009

➤ Initial version. 20091009

Table A.1 Firmware Revision History (Sheet 2 of 2)

Firmware Identification 
(FID) Number

Summary of Revisions
Manual 

Date Code
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Table A.2 Instruction Manual Revision History (Sheet 1 of 3)

Date Code Summary of Revisions

20181001 Section 1

➤ Updated Specifications.

20180613 Section 1

➤ Updated Table 1.1: Radio Antenna and Cable Accessories.

Section 2

➤ Updated Table 2.2: Antennas Permitted for Use with the SEL-3031.

Section 4

➤ Updated Table 4.14: Factory-Default Passwords.

➤ Updated Table 4.18: SER Command.

20180330 Section 1

➤ Updated Compliance in Specifications.

Appendix B

➤ Updated Technical Support.

20160804 Section 1

➤ Updated Table 1.1: Radio Antenna and Cable Accessories.

20160203 General

➤ Updated cable information to include RG-8X.

Section 1

➤ Updated Table 1.1: Radio Antenna and Cable Accessories.

20150203 Preface

➤ Updated Safety Information.

Section 1

➤ Updated Table 1.1: Radio Antenna and Cable Accessories.

➤ Added Figure 1.1: Radio Antenna Connections.

➤ Changed Certifications to Compliance, and moved it to the beginning 

of Specifications.

➤ Added Power Consumption With SEL-3044 Card in Specifications.

➤ Updated Table 1.2: Government Approvals.

Section 2

➤ Updated Figure 2.6: SEL-C693 Cable: Two-Wire EIA-485 Connections.

Section 4

➤ Added CAL Level information.

Section 5

➤ Updated fade margin and radio availability information in Monitoring 

and Improving Radio Link Performance.
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Appendix A

➤ Updated Table A.1: Firmware Revision History with correct FPGA ver-

sion.

20141120 Section 1

➤ Updated surge protection description and part number in Table 1.1.

Section 2

➤ Updated surge protection information in Lightning Protection.

20130208 Section 1

➤ Added UL, cUL, and FIPS 140-2 certification information to Specifica-

tions.

20111228 Appendix A

➤ Updated for SEL-3031 firmware version R104.

➤ Updated for SEL-3044 firmware version R102.

20111005 Section 1

➤ Added certification information for Colombia to Specifications.

➤ Added Brazil ANATEL Numbers to Specifications.

Section 2

➤ Added Colombia to list of countries allowing six skip zones.

20110818 Section 1

➤ Added 9600 bps SPEED setting option for radios without encryption 

cards.

➤ Updated port speed option and latency tables in Specifications to reflect 

9600 bps SPEED setting option for radios without encryption cards.

➤ Added certification information for Brazil, Mexico, and Peru to Specifi-

cations.

Section 2

➤ Added 9600 bps SPEED setting option for radios without encryption 

cards.

➤ Added 303011Brazil locked skip frequencies.

➤ Added Table 2.4: 900 MHz Frequency Skip Zones for Brazil (part num-

bers starting with SEL-30311).

Section 3

➤ Added 9600 bps SPEED setting option for radios without encryption 

cards.

Table A.2 Instruction Manual Revision History (Sheet 2 of 3)

Date Code Summary of Revisions
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Section 4

➤ Added 9600 bps SPEED setting option for radios without encryption 

cards.

➤ Added 303011Brazil locked skip frequencies.

➤ Added Table 4.6: Skip Zone Frequencies (SEL-30311 Brazil).

Appendix A

➤ Updated for firmware version R103.

20101108 Section 1

➤ Added P2MP capability to product features.

➤ Included additional antenna accessories in Table 1.1: Radio Antenna 

and Cable Accessories.

Section 2

➤ New SEL Sync-Hop for collocated radios.

➤ Updated Table 2.9: SEL-3031 Port Description for Port 3 radio syn-

chronizing capability.

➤ Added Figure 2.12: SEL Cable C576: Synchronizing Cable for 

SEL-3031, new cables for synchronizing radios.

Section 3

➤ Added two more Job Done examples.

Section 4

➤ Added P2MP capability to product features.

➤ Updated Figure 4.9: Radio Strength and Channel Availability with new 

graphical Radio Status.

➤ Updated Table 4.4: Radio Settings with P2MP and synchronizing set-

tings.

➤ Added information on SYNC and KEY settings.

➤ Updated Table 4.6: Port Settings with SPEED and ARQ.

Appendix A

➤ Updated for firmware version R101.

Appendix B

➤ Added Firmware Upgrade Instructions.

20091009 ➤ Initial version.

Table A.2 Instruction Manual Revision History (Sheet 3 of 3)

Date Code Summary of Revisions
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Appendix B
Firmware Upgrade Instructions

Overview

SEL may occasionally offer firmware upgrades to improve the performance of your 

radio. The radio stores firmware in Flash memory; therefore, changing physical 

components is not necessary. A firmware loader program called SELBOOT resides in 

the SEL-3031. These instructions give a step-by-step procedure to upgrade the radio 

firmware by uploading a file from a personal computer to the radio via direct 

connection to the USB management port.

Required Equipment

You will need the following to perform a firmware upgrade.

➤ Personal computer

➤ Terminal emulation software that supports the Xmodem/CRC 

protocol (these instructions use HyperTerminal® from a Microsoft® 

Windows® operating system)

➤ USB Type-B cable (SEL-C664 or equivalent)

➤ The firmware upgrade file (Rxxx3031.img)

Firmware Upgrade Procedure
Step 1. Connect a standard USB Type-B cable from the PC to the 

management port of the SEL-3031, and enter Access Level 2.

a. Type ACC <Enter>.

b. Enter the Access Level 1 password.

c. Type 2AC <Enter>.

d. Enter the Access Level 2 password.

Step 2. Start the upgrade process.

a. Issue the L_D command to the radio.

b. Type Y <Enter> at the following prompt:

Disable device to receive firmware (Y,N) ?
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c. Type Y <Enter> at the following prompt:

Are you sure (Y, N)?

The radio will respond with the following message and send the !> 
prompt.

Device disabled

Step 3. Issue the BAU 115200 command. On your terminal or computer 
terminal program, change the terminal data rate to 115200 bps.

Step 4. Begin the transfer of the new firmware to the radio by issuing the 
REC command.

Step 5. Type Y to erase the existing firmware, or press <Enter> to abort.

Step 6. Start the file transfer.

a. Select the send file option in your communications software.

b. Use the Xmodem or 1K Xmodem protocol and send the file 
that contains the new firmware.

After the file transfer, the radio reboots and returns to Access Level 0. 
Change the terminal data rate back to 9600 bps to access the radio 
management port.

Step 7. Press any key (e.g., <Enter>) when the radio sends a prompt.

Step 8. Type ACC <Enter>. Enter the Access Level 1 password.

=>>L_D <Enter>

Disable device to receive firmware (Y,N) ? <Enter>

Are you sure (Y/N) ? Y <Enter>

Device disabled

!>REC <Enter>

Caution! This command erases the firmware.

If you erase the firmware then new firmware

must be loaded before returning the IED to service.

Are you sure, you want to erase the existing firmware (Y/N)? 

Y <Enter>

Erasing firmware.

Erase successful.

Press any key to begin transfer and then start transfer at the terminal.
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Step 9. Issue the STA command, and examine the status report for FAIL 

messages. 

If the status report shows a FAIL message, perform the following 

steps.

a. Type 2AC <Enter>.

b. Enter the Access Level 2 password.

c. Type R_S <Enter>.

d. At this time you must reenter passwords.

e. Type ACC <Enter>.

f. Enter the Access Level 1 password

g. Type 2AC <Enter>.

h. Enter the default Access Level 2 password.

i. Use the PAS command to change the default password to 

your secure password (refer to the SEL-3031 Instruction 

Manual).

Step 10. Turn the radio off and back on.

This completes the firmware upgrade instructions. If you have an FPGA configuration 

upgrade, continue with the following procedure.

FPGA Configuration Upgrade Procedure
Step 1. Connect input power.

Step 2. Connect a standard USB Type-B cable from the PC to the 

management port of the SEL-3031, and enter Access Level 2.

Step 3. Start upgrading of firmware.

a. Issue the L_D command to the radio.

b. Type Y <Enter> at the following prompt:

Disable device to receive firmware (Y,N) ?

c. Type Y <Enter> at the following prompt:

Are you sure (Y, N)?

The radio will respond with the following message and send the !> 
prompt.

Device disabled
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Step 4. Issue the BAU 115200 command, and change the terminal data rate to 

115200.

Step 5. Begin the transfer of the new FPGA configuration file 

(RTL_Rxxx3031.cxf) to the radio by issuing the REC FPGA 

command.

Step 6. Type Y to erase the existing FPGA configuration or press <Enter> to 

abort.

Step 7. Press any key (e.g., <Enter>) when the radio sends a prompt.

Step 8. Start the file transfer.

a. Select the send file option in your communications software.

b. Use the Xmodem protocol and send the file that contains the 

new firmware.

After the file transfer, the radio will reboot and return to Access 

Level 0.

Step 9. The FPGA upgrade will cause the radio to restart (equivalent to 

removing and restoring power). On most PCs you will need to exit 

and restart the terminal program for it to re-recognize the serial port. 

Change the terminal data rate back to 9600 bps to access the radio 

management port.

=>>L_D <Enter>

Disable device to receive firmware (Y,N) ? Y <Enter>

Are you sure (Y/N) ? Y <Enter>

Device disabled

!>REC FPGA <Enter>

Caution! This command erases the FPGA.

Do not interrupt power during FPGA upload

or the device may require factory reprogramming.

Are you sure you want to erase the existing FPGA (Y/N)? Y <Enter>

Press any key to begin transfer and then start transfer at the terminal.

Completed FPGA configuration upload into RAM.

Beginning FPGA reconfiguration.

Erasing FPGA ... (15 seconds) ... Done.

Configuring FPGA.

 37 .....................................................................

 36 .....................................................................

 35 .....................................................................

 34 .....................................................................

 33 .....................................................................

 32 .....................................................................

 31 .....................................................................

 30 .....................................................................

 29 .....................................................................

 28 .....................................................................

 27 .....................................................................

 26 .....................................................................

 25 .....................................................................

 24 .....................................................................

 23 .....................................................................

 22 .....................................................................

 21 .....................................................................

 20 .....................................................................

 19 .....................................................................

 18 .....................................................................
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 17 .....................................................................

 16 .....................................................................

 15 .....................................................................

 14 .....................................................................

 13 .....................................................................

 12 .....................................................................

 11 .....................................................................

 10 .....................................................................

  9 .....................................................................

  8 .....................................................................

  7 .....................................................................

  6 .....................................................................

  5 .....................................................................

  4 .....................................................................

  3 .....................................................................

  2 .....................................................................

  1 .....................................................................

FPGA Configuration complete................

The SEL-3031 now is ready for commissioning.

Technical Support

We appreciate your interest in SEL products and services. If you have questions or 

comments, please contact us at:

Schweitzer Engineering Laboratories, Inc.

2350 NE Hopkins Court

Pullman, WA 99163-5603 USA

Telephone: +1.509.338.3838

Fax: +1.509.332.7990

Internet: selinc.com/support

Email: info@selinc.com
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Appendix C
SEL-3044 Encryption Card

Overview

The SEL-3044 Encryption Card is a standalone card that can be added to the SEL-3031 

to encrypt the radio data being sent between SEL-3031 radio links. The SEL-3044 can 

be ordered at time of purchase or added as an upgrade. The SEL-3044 requires one 

setting to provide a very strong level of encryption over the radio link. Use of the 

SEL-3044 is strongly advised for any application of the SEL-3031 for critical data. If 

you do not use the SEL-3044, the data between the radios can be compromised. If you 

want to encrypt the radio link, an SEL-3044 is required in both radios.

NOTE: The SEL-3044 is NOT a PCMCIA card. Do not install 
in a laptop computer.

Figure C.1 SEL-3044 Encryption Card

NIST FIPS 140-2 Level 2 Security 
Requirements

The National Institute of Standards and Technology (NIST) developed the Federal 

Information Processing Standards (FIPS) 140-2 standard that defines the security 

requirements for a cryptographic module used within a security system protecting 

sensitive information in computer and telecommunications systems. 
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Protection of a cryptographic module within a security system is necessary to maintain 

the confidentiality and integrity of the information protected by the module. 

FIPS 140-2 Level 2 covers areas related to the secure design and implementation of 

a cryptographic module. 

These areas include the following:

➤ Cryptographic module specification 

➤ Cryptographic module ports and interfaces

➤ Roles, services, and authentication 

➤ Finite state model

➤ Physical security

➤ Operational environment

➤ Cryptographic key management

➤ Electromagnetic interference/electromagnetic compatibility 

(EMI/EMC)

➤ Self-tests

➤ Design assurance

➤ Mitigation of other attacks

The SEL-3044 meets FIPS 140-2 Level 2 requirements and has been FIPS 140-2 

validated (historical, pending re-validation). This level of data security provides 

assurance that best practices have been applied to the design, testing, and 

manufacturing of the SEL-3044.

Theory of Operation—SEL Protocol

Encryption Components

A cryptographic device consists of three components: encryption algorithm, key 

management, and device security functions.

Encryption Algorithm

The Advanced Encryption Standard (AES) algorithm with a key length of 256 bits is 

implemented in the SEL-3044. This algorithm is a secure means of encrypting data. 

The AES algorithm and key length provide proven resistance to modern cryptanalysis.
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Key Management

System key (256 bits): The system key is set by a passphrase of 8 to 80 characters. The 

passphrase is used to generate a system key. The system key is used to encrypt and 

securely transmit unique session keys (see following text). It also provides a 

cryptographic authentication mechanism for rejecting session requests by unauthorized 

SEL-3044 devices.

Session key (256 bits): Session keys are used to encrypt all protected user data prior to 

transmission. They are produced at system startup and periodically during sessions. 

Session keys are generated using the process outlined by FIPS 186-2. They are 

produced using an integrated physical random number generator (RNG) and a 

statistical data whitening algorithm. Session keys are purely random and are not linked 

to the system key. The use of unique session keys limits the amount of data that is 

encrypted with a single key value, thus strengthening the system against 

cryptanalytical attack. The session keys are encrypted using the system key prior to 

being exchanged between SEL-3044 devices.

Device Security

The SEL-3044 incorporates a hardware RNG and FIPS-approved data whitener to 

guarantee that all session keys contain 256 bits of entropy (i.e., completely random). 

This guarantees that encoded messages are protected by a true cryptographic strength 

of 256 bits.

Multilevel password authentication defines user security roles.

Changing the system key can only be performed by authorized users who have Access 

Level 2 passwords.

If required, an authorized user can reset the entire device. This allows the user to 

reinitialize the system key should the security parameters need to change because of IT 

security procedures or if the programmed system key value is lost.

NOTE: This process requires physical access to the 
SEL-3031 and cannot be done remotely.

Security of the Transferred Data

The SEL-3044 provides data encryption with a cryptographic key strength of 256 bits. 

The SEL-3044 RNG is designed so that all possible key values are equally likely. It is 

widely accepted throughout the cryptographic community that it is not realistically 

possible to mount a successful brute force (key guessing) attack on a 256-bit key space 

with technology available today.
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Application Consideration

Two messaging structures exist to establish and maintain a secure, coherent 

communications link between two SEL-3044 devices: In-Band (IB) frames and Out-of-

Band (OOB) frames. IB frames transmit encrypted user data (i.e., data received on the 

trusted data interface) between the two protected devices (computer, IED, RTU, etc.). 

OOB frames transmit connection control data between the two SEL-3044 devices in 

the communications link. Control frames are required to implement key exchanges, 

status checks, and other functions necessary to maintain the communications link.

In-Band Message Format

IB messages consist of the encrypted data plus the frame overhead necessary to 

maintain synchronization and channel security. Figure C.2 shows the format of an IB 

frame. The shaded area is the encrypted data portion of the message.

Figure C.2 In-Band Data Packet Format

Out-of-Band Message

Out-of-Band (OOB) messages are used to exchange control information between 

SEL-3044 cards. These exchanges include loss of synchronization, request for rekey, 

and rekey information. 

IMPORTANT: During OOB message communication, data 
exchange between the devices connected to the 
SEL-3044 cannot occur. Communication will be 
temporarily halted during a rekey. 

System Settings

The system key provides encryption and secure transmission of unique session keys 

between SEL-3044 devices. It also provides a cryptographic authentication mechanism 

for rejecting session requests by unauthorized devices. Session keys provide encryption 

of all protected user data prior to transmission. An SEL-3044 produces session keys at 

system startup, and periodically during sessions, using the process outlined by 

FIPS 186-2. An integrated physical RNG and statistical data-whitening algorithm 

generate purely random session keys. Through the use of these unique session keys, the 

SEL-3044 limits the amount of data encrypted by any single key value, thus 

strengthening the system against attack. 

IB Header

Maximum of 7 Bytes User-Defined Frame Length

Protected Data
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NOTE: Both SEL-3044 transceivers that communicate with 
each other must share the same system key.

AES Overview

The AES encryption function uses a 256-bit-long secret key and scrambles the contents 

of each frame prior to transmission to provide cryptographically strong data 

confidentiality.

Encryption is the process of transforming a digital message from its original form into 

a form that an unauthorized individual cannot interpret. The output of the encryption 

process is a function of the message and an encryption key (see Figure C.3).

Figure C.3 Operation of the AES Encryption Function

This encryption process must be completely reversible by an authorized individual 

with access to the secret decryption key. Authority to read a message is only granted by 

sharing knowledge of the secret decryption key. Ideally, only individuals with 

knowledge of the decryption key can reverse the encryption operation and interpret the 

protected message. There are two main classes of encryption functions. Symmetric key 

encryption relies on the same secret key value, K, to perform both the encryption and 

decryption transformations. Asymmetric key encryption, on the other hand, uses a 

different key for encryption and decryption for example, asymmetric encryption might 

use K1 for encryption and K2 for decryption. The AES encryption algorithm the 

SEL-3044 uses is a symmetric block cipher with an encryption/decryption key size of 

256 bits.

The AES is the latest encryption standard adopted by NIST. In 1997, NIST challenged 

the cryptographic community to develop the next generation encryption algorithm to 

replace the aging DES and 3DES encryption standards. In 2000, NIST chose the 

Rijndael encryption algorithm as the AES encryption standard. During the evaluation 

of candidates for the AES standard, some of the world’s best cryptanalysts analyzed 

and approved Rijndael. Since its adoption in 2001, AES has proven to be very effective 

against known attacks, very efficient, and simple to implement.

Encryption Key Decryption Key

Hi Bob!
*4gu>g

aIL8}2=h

AES

Encrypt Hi Bob!
AES

Decrypt
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Frame Replay Protection

Every frame in a given session contains a sequence number field. The value in this field 

increments every time a frame is transmitted. The SEL-3044 will not accept any frame 

that contains a sequence number value that is less than, or equal to, the sequence 

number value received in the last frame. It is exceedingly difficult to maliciously alter 

the sequence number in any given frame to bypass this functionality because the 

sequence number field is protected by the strong cryptographic authentication 

mechanisms. Because of the protection these mechanisms provide, an attacker cannot 

capture a previously transmitted frame and resend the frame to the SEL-3044 to cause 

harmful actions.

Resetting the SEL-3044

At some point it may be necessary to reset the SEL-3044. You must have access to the 

front USB port on the SEL-3031. The SEL-3044 must be installed in the SEL-3031 to 

reset. Use either ACSELERATOR QuickSet® SEL-5030 Software or a terminal interface 

to access the Radio settings. In the Radio settings, set the KEY setting to None, save 

the setting, then set a new passphrase and save.

If you have lost your passwords to access the SEL-3031, you must disable passwords 

by temporarily installing a jumper. Refer to Password Jumper on page 2.14 and 

Table 2.7 for information and instructions on disabling passwords.

Installing an SEL-3044 in the SEL-3031

The SEL-3044 can be ordered at time of purchase of the radio, or it may be added later 

as a field upgrade. The process involves powering down the radio, removing hardware, 

installing the card, and setting the radio.

CAUTION
The radio contains devices sensitive to Electrostatic Discharge (ESD). When working on the radio 
with the front or top cover removed, work surfaces and personnel must be properly grounded or 
equipment damage may result.

Step 1. Remove the power from the radio and remove all connections from 

the device.

Step 2. Rack-mount SEL-3031: Loosen the six front-panel screws and 

remove the front panel.

Wall-mount model: Use a Torx® T15 screwdriver and remove the 

four screws located on the sides of each corner. Slide the cover up and 

back to reveal the front of the unit.

Step 3. Between the main board and radio board there is a PCMCIA card 

slot. Gently slide the SEL-3044 straight into the card slot. Push firmly 

until it is fully seated.
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Figure C.4 Encryption Card Location

Step 4. Reassemble the unit in reverse order of Step 2.

Step 5. Apply power to the unit and verify the SEC light is flashing. The 

flashing LED indicates that the SEL-3044 is functioning properly and 

is currently in Reset.

If the SEC LED is not flashing, then you must turn off the unit and 

verify the card is properly seated in the pins.

If the SEC LED does not flash upon your removing and restoring 

power and you have verified that the card is seated properly, you will 

need to send the radio and encryption card back for repair.

Step 6. Use QuickSet to connect to the device and set the KEY setting to 

enable the SEL-3044.

Step 7. The KEY setting must be set the same on both SEL-3031 transceivers 

for proper operation.
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